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1 General
1.1 About this user guide

This user guide describes the hardware, software, and usage of the ICMflex in its current version including
all available configurations. Some of the hardware features of the most recent versions are not available with
earlier versions of the instrument. It is possible to upgrade most of the previous instruments to the features of
the current instruments. Please contact Power Diagnostix for details (support@pdix.com).

Software updates are available through Power Diagnostix’s website (www.pdix.com). Access to the down-
load area of the website is password protected and requires a valid software maintenance contract. Please
contact Power Diagnostix for details. Current brochures and revisions of this manual are also available for
download (PDF format) on this website.

1.2 Instrument safety

Before using the ICMflex, read the following safety information in this manual carefully. In particular, read
and follow the information, which is marked with the words ‘Warning’ and ‘Caution’. The word ‘Warning’ is
reserved for conditions and actions that pose hazards to the user, while the word ‘Caution’ is reserved for
conditions and actions that may damage the instrument, or its accessories, or that may lead to malfunction.

Always obey the safety rules given by warnings on the instrument and in this guide. Be particularly aware of
the safety issues that can arise while performing field measurements. Never disregard safety considerations,
even under the time constraints often found with on-line and off-line tests on site.

Warning

® Always ensure solid grounding of the instrument. Use the wing nut terminal for
ground connection on the ground plate or the multi-contact connectors beside
it. Never operate the instrument without protective grounding.

® Do not work alone.

® Do not allow the instrument to be used if it is damaged or its safety is impaired.
® [nspect the ground leads and signal cables for continuity.

® Select the proper coupling circuit and connection for your application.

® Do not use the instrument in an environment where there is risk of condensation
or risk of explosion.

® Use the fibre optic link or the Bluetooth communication to operate the instru-
ment.

® Only use cables supplied by Power Diagnostix.

pdix.com User guide for ICMflex
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1.3 Health and safety recommendations
1.3.1 General safety procedures prior to testing

When working with high voltages, these topics need to be considered carefully prior to the measurement set-
up and testing.

1.

9.

10.
11.
12.
13.
14.

15.
16.

17.

The operators must have read the safety instructions and met the local site safety requirements relating
to health and possible hazards.

The sample to be tested must be offline, de-energised, and grounded.

Each operator has to check the safety conditions together with the person responsible on the site and
pass the tagout/lockout procedure for the specimen to be tested.

After the tagout/lockout procedure, the specimen must be checked for the presence of voltage in con-
junction with the person responsible on site by using a suitable HV tester.

The operator has to check for solid grounding together in conjunction with the person responsible on site.

After completing steps 1) to 5), the specimen is in a safe condition and may be connected to the test
equipment.

Find a safe area as close as possible to the specimen terminals to install the equipment.

Apply demarcation around the whole measurement set-up and make use of a safety guard, if necessary.
Do not work alone.

Only authorised personnel are allowed to enter the demarcated test area.

Warn other people working close to the hazardous area before energising the test specimen.

Check the insulation resistance prior to applying external HV potential.

Remove the calibrator before applying any external high voltage.

When applying external high voltage, carefully increase the voltage while checking that the voltage and
current stay within predefined limits.

Make sure that the sample is discharged after the external high voltage has been switched off.

Discharge and ground the test specimen with a grounding stick before changing or touching any HV
connection.

The specimen is now in safe condition, and necessary changes to the set-up can be made safely.

Please check the detailed Power Diagnostix “Health and Safety Instructions and Recommendations” guide-
lines in the case of any ambiguities regarding safety.

8 User guide for ICMflex pdix.com
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1.3.2 Health and safety risks

Incautious actions during testing can result in life-threatening hazards such as electrocution. Please be aware
that this risk applies not only to the operators but also to other people working close to the area under high
voltage. Please follow the necessary personal protection recommendations as mentioned above and in the
detailed Power Diagnostix “Health and Safety Instructions and Recommendations” guidelines so that testing
can be performed safely.

A specimen under high voltage can produce Ozone due to the presence of partial discharge activity. The
maximum permissible ozone concentration in the open air is fixed on 0.1 ppm (parts per million) in accord-
ance with the European Health Commission. Inhalation of too much ozone can lead to severe lung problems
in the short and/or long term. Please make sure that the test area is sufficiently ventilated. When necessary,
make use of personal protection equipment, and be aware of this health recommendation during testing.

1.3.3 Environmental conditions

Care must be taken to ensure that the area surrounding the test specimen is in sufficiently clean and dry
condition before installing the equipment and starting the tests. We recommend considering particularly the
temperature and relative humidity. Temperatures above 45 °C can directly affect the performance of the bat-
tery. Working in conditions of high humidity can lead to additional stray capacitances influencing the tan delta
and capacitance values, as well as the partial discharge measurement. Always make sure that the equipment
is clean and leave sufficient space between the parts under high voltage and any other objects nearby.

1.3.4 Lithium-ion battery module warnings
® This instrument may be provided with a Lithium-ion high energy battery module.

® Do not pierce, damage, disassemble, or modify the battery module. The battery module contains safety
and protection devices which, if tampered with, may cause the battery to generate heat, to rupture, or to
ignite.

® |f a battery is suspected to be faulty, replace it with a Power Diagnostix approved battery module.

® |f an instrument is suspected to contain a faulty battery module, the module must be removed before the
instrument is shipped.

@ Do not ship a faulty battery module, either separately or connected to an instrument.

pdix.com User guide for ICMflex
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2 Principle of operation

The ICMflex is a unique measurement system that covers PD detection, PD fault location on cables, and tan
delta measurements (standard ICMflex, only). It has been designed to simplify the operation and to combine
different measuring tasks with one instrument. This new principle minimises testing and operation time, in-
creases operator’s safety, and guarantees the highest sensitivity and precision. Main users of these systems
are:

® Service groups testing motors, generators, and associated accessories
® Service groups testing high voltage cables, termination, and joints

® Maintenance and repair shops

® High voltage laboratories

°

Research and development departments

The system is mainly used for on-site testing but can also be used in laboratories and workshops. It operates
with any fixed or portable high voltage power supply, such as transformers, hi-pots, resonant test systems,
motor generator sets, and VLF systems (cos/square and sine waves). Power Diagnostix offers complete sys-

tems as well as modular components. BT —

A complete acquisition system is shown in Figure 1. It consists (_\ *?:C>
of a reference capacitor C,, two shunt capacitors Cs, and Cs, a Fibre optic |_ Y aEiN® @:Xu
decoupling circuit for PD measurement, and an acquisition box — 1] cATEN® @un Ux
with battery module. If PD measurement is not wanted, the de- Csn | P
coupling circuit will not be present. For systems above 30 kV, the | | 111 }*
main box is surrounded by an aluminium electrode to smooth Un@_—— \_‘ Csx
the electrical field. Communication between a computer and the |‘
instrument can be established via Bluetooth or via fibre optic se- PD(:“

rial bus. All measurement values are displayed by the ICMflex C): o (—)
remote control software on the computer.

Two voltages can be measured with this system. Uy is taken from —

the capacitive divider between the external capacitance of the Cn

test object Cy and the internal shunt capacitor Cs. The reference 1

voltage U, is provided by the capacitive divider C./Cs.. The wave- —

form of both voltages is displayed together with the absolute val-

ues of Upea, U RMS, and Upgearsaro. The correlation of both signals

gives further results, including the tan delta value, the power fac- =T

tor, and the capacitance C of the sample under test. Due to the Q GND Q
high sampling rate of 100 kS/s and 16-bit A/D conversion, preci-

sion and accuracy can be guaranteed. Figure 1: Design of the ICMflex

The high frequency PD signal is used for PD pattern acquisition as well as for PD fault location on cables, if
needed. The PD scope has 8-bit resolution for phase and amplitude. The pulse count is up to 65536 (16 bits)
per phase-amplitude position. The sensitivity of PD measurements depends strongly on the quality of the
power supply. Power Diagnostix offers various modular filter units to block noise generated by the source
(see section 3.5). Furthermore, the instrument comes with a built-in gating input to trigger on HF pulses from
the input side. External noise signals do not interfere with the measurements as all signals are directly taken
at high voltage potential so there are no critical ground loops.

User guide for ICMflex pdix.com
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The following table shows the most common combinations and configurations of the ICMflex. Instruments for
higher voltages and other configurations are available on request. Adaptable high voltage filters are available
for all systems.

30 KV 300‘25_100 1H|f|z(r{f|_”F” 1000 pF 10 uF/100 uF
30 kV 390‘25_109 1H§z(?voerFT;) 1000 pF 3UF 40 LF/400 uF
50 kV 390‘5_109 1H§Z(R;3Lrg') 666 pF 25 uF 10 uF/100 uF
50 kV (2)9(;5_109 1H§Z(R;’Lrg') 666 pF 4 UF 40 1F/400 pF
100 kv oy 1H§Z(Rf’[,'f)") 500 pF 10 uF 10 F/100 4F
100vKV oY 1H§Z(R;’Lr,'f)") 500 pF 10 uF 40 4F/400 uF
150 KV 59525_109 1Hﬁz((r1f[g') 1000 pF 15vF 10 uF/100 uF
150 kV (2)90‘25_109 1H§Z(?v°|_rg) 1000 pF 15 uF 40 pF/400 uF

Typical filter units are listed in the table below. Please contact Power Diagnostix if modified versions are needed.

T30/1 30 kV DC-300 Hz L-C-L 6.7 nF >100
T50/1 50 kV 1A DC-300 Hz L-C-L 10 nF >100
T100/1 100vkV 1A DC-300 Hz L-C-L 10 nF >100
T100/70 100 kV 70 A DC-300 Hz L-C-L 10 nF >100
T150/1 150 kV 1A DC-300 Hz L-C-L 10 nF >100

pdix.com User guide for ICMflex 1
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Figure 2 shows a 50 kV set consisting of a T-filter T50/1 (left) and the ICMflex model for 50 kV (right).

Based on application requirements, it is possible to order the ICMflex acquisition system in various configura-
tions. The following table illustrates this modularity. Please contact Power Diagnostix to specify your required

configuration.
ICMflex The basic system offers voltage measurement, frequency measurement, together with

Bluetooth and fibre optic serial transmission ports. The black acquisition box is placed

Basi
asic system in the head of the grey case. The system is not usable without one of the following op-

tions.
ICMflex This option enables all features for loss factor measurements. The system is supplied
Option TD with customised shunt and reference capacitors. The software calculates the following
values:

Cx: Capacitance of the test object
tan delta: Loss factor of the sample under test

cos phi: Power factor of the sample under test

Optionally, the system can be fitted with a C, bypass to avoid overstressing the shunt
capacitor if the test object’s capacitance is too high.

|ICMflex This option is needed if PD measurements are to be made for the test object. The sys-
Option PD tem comes with a built-in measuring impedance on HV potential. The software displays

all PD activities in a PD scope graph, allows PD pattern acquisition, and indicates the
precise PD magnitude Q.

ICMflex This option can be chosen in addition to the PD option. A special high-speed sampling
Option LOC board with 16-bit 100 MS A/D converter enables pulse measurement vs. time. This

option is mandatory for PD fault location on cables. The software offers a special TDR
(Time Domain Reflectometry) graph and other evaluation tools.

12 User guide for ICMflex pdix.com
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3 Measurement set-up
3.1 Verifying the part list

Before commencing installation, check that all parts are available. The standard package consists of the
these items:

® Acquisition unit ICMflex,

HV filter (optional),

Battery pack type BAT2A,

Battery charger,

Fibre optic cable (10 m); USB to Sub-D
Computer including ICMflex software,

PD calibrator CAL1B or similar including connection set (optional),

Set of cables:

o 0.6 m HV cable (grey) with multi-contact connectors (male/female),

o 1.5 m HV extension cable (grey) with multi-contact connectors (male/female)

o 1.0 mHV cable (grey) with multi-contact connector (female) at one end and clamp connector at the other end,
o 1.0 m grounding lead (yellow/green) with multi-contact connectors (male/female),
o

1.5 m grounding lead (yellow/green) with multi-contact connector (male) at one end and clamp
connector at the other end,

o 74 cm RG58 cable
® Set of spare connectors; type multi-contact (male),

® User guide.

Please contact Power Diagnostix for spare parts or updates.

3.2 High voltage cabling

A set of high voltage cables is shown in Figure 3. Please be aware that the high voltage cables supplied are
non-shielded cables which must not touch or be close to ground potential. The insulation of the high voltage
cables supplied by Power Diagnostix can withstand a maximum voltage of 13.8 kV with direct contact to
ground. Nevertheless, the cable must be installed at a safe distance from any grounded objects. If the cables
are in direct contact with ground, surface discharge activity will start from 3 kV. Please check the detailed
Power Diagnostix “Health and Safety Instructions and Recommendations”. The minimum distances which are
to be observed in open air conditions, in relation to the applied voltage, are specified in Appendix 3.

Figure 3: High voltage cables

pdix.com User guide for ICMflex
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3.3 Location

As mentioned above in the general procedure prior to installation, find a safe location close to the specimen
to install the equipment. Ask for a fenced, delineated, or enclosed area, if required, as shown in Figure 4, and
avoid environmental conditions with high relative humidity and extreme temperatures.

Figure 4: MV cable testing on-site

3.4 Parts of the ICMflex under high voltage potential

The ICMflex has a unique design concept. The entire acquisition unit is at high voltage potential right where
the necessary signals are. This offers the advantage that no additional signal cables are needed. The filter
units are constructed on the same principle. The parts that are at high voltage potential are marked with warn-
ing signs to prevent confusion during set-up (see Figure 5 in section 3.5).

The complete head box, including the corona cage surrounding the top of the reference capacitor and both
MC connectors on the in- and output, is at high voltage potential. The bottom plate of the ICMflex and corre-
sponding filter unit are at ground potential.

3.5 Connecting the ICMflex

Please read the application notes for testing of medium and high voltage cables and rotating machines for
specific set-up information. In general, the main connections are explained below.

The appropriate connection of the HV source (HV transformer, resonance test set, VLF high potential) to the
filter and/or ICMflex is sown on the top covers of both the filtering unit and the ICMflex. Please follow the con-
nection arrangements shown.

The HV cable of the power supply has to be connected to the female input connector of the filter (at the left-
hand side of Figure 5) or, if a filter is not needed, directly to the input of the ICMflex. A connection needs to
be provided from the male output connector of the filter (at the right-hand side of Figure 5) to the female con-
nector of the ICMflex. Finally, the male connector of the ICMflex needs to be connected to the specimen. This
can be a motor terminal, the conductor of a shielded high voltage cable or a stator bar. The interconnection
between the filter and ICMflex is, of course, not needed if no filter is used.

User guide for ICMflex pdix.com
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Figure 5: Filter connectors

The coaxial output from the filter (left picture in Figure 6) is used for analogue noise gating. A noise decou-
pling circuit is directly built into the filter to capture any noise originating from the high voltage supply. A co-
axial connection between the filter output and the ICMflex input (right picture in Figure 6) has to be established
to use the gating option. Please prevent direct contact between the coax cable and the high voltage cable
connecting the filter and the ICMflex.

Figure 6: Coaxial gating connector for filter (left) and ICMflex (right)

The ground loop of the measuring set-up is very im-
portant. Poor grounding has a big influence on the
sensitivity because of background noise. The main
ground of the power supply has to be connected to
the ground terminal of the filter unit or, if no filter is
used, directly to the ICMflex. Connection points are
provided on the metallic grounding plates, as shown b
in Figure 7. Connections can be made by using a ca- Figure 7: Ground connection points

ble lug or a multi-contact. Use the short cables sup-

plied to interconnect the grounding of the filter and the grounding of the ICMflex. Avoid loops since these will
act as an antennas and influence the noise behaviour. Finally, a connection, which should be as short as
possible, must be established between the ICMflex and the main grounding of the test specimen. Please
choose a solid grounding connection and ensure good contact. Interconnection between the grounding of
the filter and the ICMflex is not necessary if no filter is used. A typical test set-up is shown in Figure 10.

pdix.com User guide for ICMflex
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The most convenient way to communicate with the instrument is via
the Bluetooth interfaceas this requires no additional cabling. Howev-
er, if a Bluetooth connection cannot be established, it is possible to
use the fibre optic serial link instead. The D-Sub female connector of
the cable has to be connected to the male connector on the upper
side of the ICMflex (as shown in Figure 9). The cable USB connector
of the cable can be connected to any free USB port on the computer.
As the fibre optic cable provides a galvanic separation from the high
voltage potential, there is no risk to the operator.

Caution and Warning: Never use a standard D-Sub cable that does
not galvanic separation. This can result in damage to components
and serious injury or death.

HV filter with analogue gating output

é HV cable

female

Figure 9: SUB-D input connector

ICMflex

BNC (analogue gate in)

FO (TTL gate in)

RG58
AN
<
L& 71 O
GND ~ - ~ o ™ ™= m
I —-—--—--_— GND =
]
1
I
é I
I GND o
[— d
High voltage supply
eg.,
VLF system,
transformer,

resonant test system,

Figure 10: General connection diagram for ICMflex

User guide for ICMflex
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4 Software and driver installation

The ICMflex is supplied with a Windows based software package on a USB stick or CD. The software can be
installed on Windows operating systems versions 7, 8, and 10 with 32-bit or 64-bit architecture. If a computer
is provided by Power Diagnostix, the software and the instrument drivers are pre-installed and ready config-
ured. In this case, no further action is needed but, in all other cases, the following preparations must be made.

4.1 Installing the ICMflex software

Start the setup.exe file that can be found within the ICMflex directory on the USB stick. If a new software ver-
sion has been downloaded from the internet, unzip all files to a local directory on the target system first. After
starting the setup.exe file, a window like the one shown in Figure 11 below will pop up.

Please choose custom installation directories, if wanted,
and click “Next”. The installation kit automatically detects
earlier versions and updates only these with newer files
provided by this release. This software has been devel-
oped under National Instruments LabWindows/CVI.
Therefore, additional DLLs and libraries will be installed
automatically within the Windows system directory. Ad-
ministrator rights are necessary to complete the installa-
tion of this software product. Please contact your system
administrator if you have insufficient rights on this ma-
chine.

After finalising the software installation procedure, the
system restarts automatically.

further preparations must be completed.

ICMflex 2.06

Figure 12: Desktop icon

-
57 ICMflex 1.54 =R
|

Destination Directory
Select the primary installation directory.

A& zoftware will be installed in the following locations. Ta install saftware into &
different locations, click the Browse button and select another directory.

Target directory for application
|C.\udu\iuﬁware\lCMﬂax\lCMﬂax 1544

| [ Browse, ]

Target directom for Mational Instruments software
|C'\nglam Files x86)\National Instruments'.

| [ Browse: ]

[ << Back ‘E MNext »> i [ LCancel

Figure 11: Software installation setup

The ICMflex software can be started directly by clicking on the appropriate icon (as shown in
Figure 12) on the desktop. Before starting to communicate with the instrument, however,

pdix.com

User guide for ICMflex
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4.2 Setting up a Bluetooth COM port

All Bluetooth devices on computer systems can provide so-called virtual COM ports. These COM ports are
used to establish a connection with the ICMflex. Standard laptops usually come with built-in Bluetooth inter-
faces. If such an interface is not available, it is possible to use external USB-Bluetooth devices. Power Diag-
nostix can provide these devices for USB, PCI, and other interfaces. The Bluetooth interface on any comput-
er provides an automatic scanning function. Please start this function to find the ICMflex Bluetooth device.

Select a device to add to this computer

Windows will continue to look for new devices and display them here,

Searching for devices... Make sure your device is discoverable,

, ]
U _Luf' Add a device
Select a device to add to this computer
Windows will continue to look for new devices and display them here.
_ MAYLAP i ICMflex SN 110
Bluetooth T Bluetooth
= Laptop computer [;z) Phone
What if Windows doesn't find my device?
e ]

Figure 13: Bluetooth connection wizard

Figure 14: Adding a Bluetooth device

The express mode will guide you through this set-up (Figure 13). Click “Next”. The search routine can take a
few minutes. A pop-up window will display all devices found in range (Figure 14). Select the “ICMflex” entry

and continue the installation procedure (

Figure 15).

It is mandatory to set the device code (Figure 16) for the ICMflex connection to “0000”.

r 52 B r 52 B
'\-—) Lﬂf‘Addadew:e @ Lﬂf‘Addadevi:e

This device has been successfully added to this computer Enter the pairing code for the device

Windows is now checking for drivers and will install them if This will verify that you are connecting to the correct device.

necessary. You may need to wait for this to finish before your device ’i

is ready to use, i |

To verify if this device finished installing properly, look for itin I The code is either displayed on your device or in the information that

Devices and Printers. = came with the device, =3

ICMflex SN 110 ICMflex SN 110
What if ] can't find the device pairing code?

Figure 15: Bluetooth device successfully added Figure 16: Entering pairing code
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) Device Manager o e

File Action View Help
L AIEI AT T

42 goedertier-PC B
b Batteries i
© | 2| Biometric Devices
5} Bluetooth Radios
5 {8 Computer
b g Disk drives
> B, Display adapters
b & DVD/CD-ROM drives
> L5 Human Interface Devices
b € IDE ATA/ATAPI controllers

> Zg Imaging devices
> Keyboards

I

emory technology driver
Mice and other pointing devices

4 75 Ports (COM & LPT)
i 75 CP210x USB to UART Bridge Controller (COMT)

Figure 17: Windows Device Manager

If, successful, the Windows hardware manager will automatically install a virtual COM port for the new device.
Typically, two COM ports will be installed for the ICMflex as shown in Figure 17. Enable both with the ICMflex
software interface settings as described in section 5.2.

4.3 Setting up a fibre optic communication port (USB serial COM)

A special fibre optic cable is supplied with the ICMflex. The D-Sub male connector has to be connected to
the COM TTL female connector of the instrument box. The case of the D-sub plug contains the hard wired
connection to the fibre optic converter. The default length of this cable is 10 meters. Individual lengths can be
supplied on demand. The side with the USB-A connector contains a fibre optic to USB converter. This end
can be connected to any free USB port of the laptop or PC. The driver for the fibre optic cable will be installed
with the software. Please do not connect the cable to the computer before the software is installed! If the driv-
er is not installed correctly, Windows will start the hardware installation wizard (as shown in Figure 18) when
connecting the USB connector to the computer for the first time.

To guarantee correct installation, it is recommended to perform the installation procedure while being con-
nected to the internet. The Windows hardware manager searches the Windows driver library on the internet to
find a suitable driver for this new device. Please contact Power Diagnostix in case of problems.

Welcome to the Found New

Found New Hardware Wizard
Hardware Wizard

“windows will search for curent and updated software by . This wizard helps you install software for:

looking on your computer, on the haidware installation CD, or on
the "Windows Update "Web site [with pour permizsion].

Biead our privacy policy

USE <-» Serial

Can ‘Windows connect to %indows Update to search for \‘g !:"‘;ﬂ;]l;pr;aa?;a';:;:nﬁ :‘;l:-an installation CD

software?

% ‘e, this time only

 Yes, now and svery time | connect a device Wwhat do you want the wizard to do?
7 No, not this time ' |nztall the software automatically (Recommended)
= Install from a list or specific location [Advanced)

Click Mext to continue. Click Mext to continue.

< Back I Mext > I Cancel < Back I Mext » I Cancel

Figure 18: Driver installation wizard
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If the computer does not recognise the cable, the drivers need to be installed manually. Go to the device
manager and select the related COM port. After a right mouse click, select “Update driver”. A window similar
to that in Figure 18 will pop up. Find the driver in a subfolder named “USB Driver\CP210x” in your ICMflex
software installation directory, e.g.,

C:\pdix\Software\ICMflex\ICMflex.186]\USB Driver\CP210x.

k ]

'\_—) ﬂﬂpd&te Driver Software - CP210x USB to UART Bridge Controller (COMT) @ jﬂ‘_gpdate Driver Software - CP210x USB to UART Bridge Controller (COMT)

How do you want to search for driver software? Browse for driver software on your computer

. i Search for driver software in this location:
= Search automatically for updated driver software

Windows will search your computer and the Internet for the latest driver software C:\pdid Software\ICMle\ ICMflex 1600\USB Driver\CPZ10x_v4.40 IS
v;c;;tly:;sr device, unless you've disabled this feature in your device installation elude Sibfakes

= Browse my computer for driver software
Locate and install driver software manually.

# Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

Cancel Cancel

Figure 19: Driver installation

This procedure must be performed twice: the first time for the USB cable itself and the second time for the
cable converter.

The setup routine will automatically install the USB serial COM port, if found, and a new COM port (e.g.,
COM?7) will be displayed by the device manager.

- '
TR B =5
A -

File Action View Help
%@ E Hm E| F&S

4 goedertier-PC 7
s

S ada
b &) DVD/CD-ROM drives
» U5 Human Interface
b g IDE ATAJATAPI controllers

]

© 5] Memory technology driver
& - Mice and other pointing devices
v =] Modems
» B Monitors
-8 Network adapters
» I Portable Devices
4 77 Ports (COM & LPT)
{75 CP210x USE to UART Bridge Controller (COMT)|
7 N5321 gw Mobile Broadband Device Management (COM6)

N5321 gw Mobile Broadband GPS Port (COM3)
o JE Processors
& -[® Security Devices
b [ Smart card readers
+.#@l Saund viden and name contrallers

Figure 20: Device Manager

Note that the COM port number has to be enabled within the interface settings of the ICMflex software (see
section 5.2). After restarting computer, the software will automatically search for the COM port in use. If the
software can’t find the COM port, check manually in the device manager as shown in Figure 20.
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5 ICMflex software
5.1 First steps

The ICMflex software has a default factory settings at start-up. All settings will be saved when closing the ap-
plication. When they are changed, settings affecting the acquisition circuit are sent to the ICMflex acquisition
box. The instrument acts as slave, and the software acts as master.

Note: If the application window appears very small when started on a PC with Windows 10, please refer to
section “10.2 Troubleshooting” on page 85.

If not yet connected to an instrument the software displays all data for the last measurement. This data is
saved in an fIx file into a specified storage directory, e.g.,

c:\pdix\software\ICMflex\ICMflex.154\icmflex.flx
All optional program preferences like colours, interface settings, etc. are stored in a file called
c:\pdix\software\ICMflex\ICMflex.154\icmflex.ini

The main program appears as a shortcut link on the desktop, in the “Start”->"Programs” folder, and can be
started directly from the installation directory. A screenshot of the main program with an ICMflex connected
is shown in Figure 21.

c:\pdix\software\ICMflex\ICMflex.154\icmflex.exe

File Edit Connect Options Tools Help

=) 9| &= & [Fo o m &l

212 Inas = 112.7 A N= 167511

g Max Hold

“m_mm-‘m—-m

’ Repor Calibrate ’ Cop ’ nad ’ Save | Search ‘ Start Rec Start Pattern Print

Figure 21: Main screen of the ICMflex software
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5.2 Connecting to the instrument

Before connecting to the instrument, it is recommended to check
the COM port settings in the menu “Options”->"Interface Set-
tings” as shown in Figure 22. Enable the port number specified
for Bluetooth or fibre optic communication (see sections 4.2 and
4.3). Normally, the software automatically searches the instru-
ment when the check box “Search Device at Startup” is selected.
The COM port in use will be indicated by the * symbol. If this is
not the case, the correct settings can be found with the Windows
device manager.

Make sure that only one COM port is enabled. First, disable all
ports by pressing the “Disable All” button. Then select the COM
port from the list by clicking the corresponding checkbox. All oth-
er settings remain unchanged and do not need to be modified
during standard operation.

All changes will become active after closing this panel by press-
ing the “OK” button. The “Cancel” function closes this window Figure 22: Interface settings
without any changes to the values. Pressing the “Standard” but-

ton enables the default COM ports and sets all timeouts back to these default values:

Search Timeout: 2 s
Run Timeout: 5 s
Baud rate: 921600 kBit/s

To connect with an instrument, press the “Search” button on the front panel. This function can be started by
using the command button at the bottom of the window, or by selecting the “Search” function from the func-
tion keys at the bottom of the window. Important functions can also be activated by shortcuts. For the search
routine, press the function key F5.

The search pop-up window shows if an instrument was found
and successfully connected. If new firmware for the acquisition
unit is available with the software, it is possible to flash the instru- ‘ICifiex found &t COME
ment’s program memory directly. A pop-up window (see Fig-
ure 23) will appear and can be confirmed by the user. Do not in-
terrupt the flashing procedure and contact Power Diagnostix in
case of problems. Usually, the latest firmware will be stored into
a new instrument.

Figure 23: Searching for ICMflex COM ports
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5.3 Firmware updates and configuration files

After a software upgrade, a pop-up window may appear indicating the availability of a new firmware version
(see Figure 24). Do not hesitate to install the update, as it will include important enhancements for the unit.

| |
A new Firmware Update is available.
Please go to 'Tools -> Device Information...' to install the new Firmware I

Updating from Firmware Versions prior 1.26 requires an additional

configuration file for your device. Please contact Power Diagnostix
to receive the correct configuration file.

Figure 24: New firmware pop-up Figure 25: Configuration file pop-up

Updates of firmware version = 1.26 require a configuration file after the first launch. Normally, the latest
ICMflex units are configured at the factory. If you update from an older version, a pop-up will appear as shown
in Figure 25. To receive a configuration file for your device, please contact the Power Diagnostix software
department (software@pdix.com) and quote the instrument’s serial number.

Once stored in the device, this configuration does not |
need to be repeated. The configuration file contains all
important information about the instrument, such as the
capacitor values according to the voltage calibration, Cn

and Csn and the shunt capacitor Csx high and low. These
settings can be cross checked via the menu “Edit”->"Ad-
vanced Settings” (see Figure 26).

Firmware and configuration files can be uploaded us-
ing the device update function, available via the menu
“Tools”->"Device Information”. A screenshot of the up-
date tool is shown in Figure 27. A firmware file is identified
by the extension .bin, a configuration file by the extension
.cfg.

After a successful upload, the communication with the instrument
will be briefly interrupted and then automatically re-established af-
ter rebooting the acquisition box.

COM Fart: COM 5
| te: 921600

c\Users\goedertierDesktoplicmflex1 27 bin

c\Users\goedertienDesktop\SMOG2. cfg

Figure 27: Firmware update window
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The device configuration panel shows detailed information about the instrument, e.g., the serial number and
installed firmware version. To access this information, connect to the instrument and open the device con-
figuration panel. A screenshot of the device configuration is shown in Figure 28. Since the instrument can be
ordered in different configurations, check that all features are available as expected, e.g.,

® Partial discharge measurement
® Partial discharge fault location for cables

® Tan delta and loss factor measurements including voltage and frequency acquisition

Besides the instrument options, the information panel also shows the battery monitoring parameters such as
the battery voltage, current, charge, and battery lifetime.

] 0 e

Figure 28: Device configuration panel

5.4 Principle of operation

The ICMflex software has a typical front-panel system that gives access to all main functions, graphs, and
settings. This panel, as shown on the next page, is divided into four main areas. These areas vary depending
on the display mode that is chosen. Available display modes are PD, LOC, and REC.

5.4.1 PD display mode

The PD display mode shown in Figure 29 is mainly used for PD measurements and is required for calibration
of the apparent charge’s amplitude. For cable testing, the cable length and pulse velocity can also be cali-
brated in this screen.

The upper left area of the window shows the voltage waveforms (12-bit resolution) for the voltage dividers Us,
(reference path) and U (specimen path), the voltage and frequency values, and, if supported by the system,
the loss factor and capacitance values. The graph in the upper right-hand part of the screen continuously dis-
plays a two-dimensional representation of PD activity vs. phase, accumulated over multiple refresh cycles.
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File Edit Connect Options Tools Help

=) 8| %/ Bl | o oo gl

212 Inas = 1127 A

ng  Wax Hold

o susll ous 0000 m B isremusl v P of

’ ’ ’ | ‘ Start Rec Start Pattern Erint | Exi

Figure 29: PD display mode

Additionally, the current PD peak magnitude is shown in the upper left corner of this graph. The magnitude must
be calibrated (see applications notes in section 5.7). The time domain graph in the lower left area can be used
to evaluate single PD events and the reflections of pulses, as detected on medium and high voltage cable in-
sulation systems, on a time-based curve (resolution of 100 Msamples/second). The different cursors help de-
termine the exact fault position and to get precise results. In the lower right area of the windows, a three-dimen-
sional PD pattern acquisition can be initiated and visualised. The phase-resolved PD pattern has a resolution of
8 bits x 8 bits with a 16-bit colour depth and allows further interpretation of failures within the insulation system.
As well as the pattern itself, the related discharge levels, set time, and the number of events are shown.
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5.4.2 LOC display mode

The LOC display mode is used to perform PD fault location measurements on medium and high voltage ca-
bles. An ICMflex with the LOC option for cable fault location incorporates a digital storage oscilloscope (DSO)
to display partial discharge signals on a time-based curve. Single PD pulses can be triggered with a time
resolution of 10 ns (100 Msamples/s) and a maximum display range of 320 us (firmware version = 1.25)
which corresponds to a theoretical maximum cable length of approximately 22 km for a cable with a pulse
velocity of 140 m/us. The DSO panel is at the lower left in PD and LOC mode (see Figure 30). As well as the
DSO display, both PD representation charts remain available in upper and lower areas on the right-hand side.
In the upper left screen, a summary of the measured reflections versus the position of occurrence along the
cable length can be shown.

To perform cable fault location (LOC), the length of the cable and/or the pulse velocity of the cable must be
known in advance. Time domain reflectometry (TDR) is based on the travel time of pulses. Since a cable be-
haves as a wave conductor, the TDR principle can be used to locate sources of partial discharges along the
full cable length.

A partial discharge pulse that is caused by an insulation imperfection travels to both ends of the cable. For
an open end (no load attached, or high impedance load compared to the cable’s characteristic impedance),
a partial discharge pulse occurring somewhere in the cable will, when it reaches the end of the cable, be re-
flected toward the opposite end. The distance of the PD source to the near and/or far end of the cable can be
calculated using the time difference between the arrival times of pulses at the measuring impedance (coupling
capacitor).

$ Fower Dingnosti -ICMflex B [E=EEER )

| File Edit Co o Tools  Hel

0.67us
6.29 us
5.62us

57.2m
5340m
476.9m

Figure 30: LOC display mode
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The principle of the time domain reflectometry is illustrated in Figure 31. The travel paths of the first three reflec-
tions of the original partial discharge pulse that enter the coupling unit of the ICMflex are displayed in different

colours.
< Xo= At12 : VC/ 2 )54 X1= At1 . VC/ 2 >
nd & !
( |
19t < : Y
ICMflex R 1/Pulse source
! .
= ’I{I M
) v )
| [ Near end ' Far end (open)
O = 0 .
Figure 31: TDR principle
In Figure 32, the three impulses are shown as they I e
would appear on the ICMflex DSO screen. The ref- =000 R 1 A 4= sa4us
erence pulse (R, black cursor) travelled directly mv] 2= 108Bus

from the pulse source to the coupling unit. The first
reflection (1%, green cursor) travelled first in the op-
posite direction, away from the coupler and was
reflected at the open end of the cable. This result-
ed in a time delay At that indicates the distance of
the PD source from the far end of the cable. Final-
ly, the second reflection (2", blue cursor) shows
the time delay between the reference pulse and its
reflection at the far end. The time difference be-
tween the first and the second reflection is a time

00 *W)\,& A

2= 544 us

¥1= 461.0m

¥w2=9219m

-5000 ¥12= 461.0m
0.0 95 [us] 19.0

Figure 32: ICMflex DSO screen

delay Aty, representing the distance of the pulse source from the near end of the cable. See the application

notes in section 6.1 for a detailed example.

pdix.com
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5.4.3 REC display mode

The REC display mode is used to show results in a summarising table or graph. The collected data can be
displayed vs. time or vs. voltage. The voltage graph in the upper left area remains unchanged. The strip chart
at the upper right-hand side always shows the actual measurement readings, while the lower left chart shows
the values from the data table at the lower right. Figure 33 shows the data plotted against voltage. By chang-
ing the setting of the X-axis to “vs. Time”, the values will be shown as a function of time. The table gives an
overview of voltage, tan delta, and tan delta tip-up (see also section 6.1), the specimen capacitance, and the
peak discharge level at the moment of triggering.

-2.10E-04
295E-04
419E-04 119574
520E-04 1196846
1.18E-03  119.691

5.39E-03| 1.90E-03| 119.652

B8.39E-03 3.00E-03  119.650

3.86E-03| 119.525

Cor 7 4 | wmopr 2090nF 4450w Am | Meus || v.vohage || WOtz

Erint ’

Figure 33: REC display mode

The strip charts in the corner on the upper right and lower left sides show:

® Green: Capacitance of the sample under test (Cx)

® Blue: Supplied voltage level (U), as RMS, peak, or peak/v2
® Black: PD magnitude in pC (Qp)

® Red: Loss factor (TD)

With each data refresh from the instrument, the latest values are shown in the two upper charts. A full meas-
urement can be recorded manually or automatically by defining a measurement sequence.

User guide for ICMflex pdix.com




ICMflex
Partial discharge and loss factor measurement system

When using manual mode, the measurement is started by pressing the “Start Rec” button. To store readings,
the “Trigger” button is used, when the required voltage step is reached. Relevant data, such as the applied
voltage, tan delta, tan delta tip-up value, capacitance, and apparent charge levels, will be registered and
show as graph versus voltage or time in the lower left of the screen.

An automatic trigger mode is included and is selected by setting the record mode to “Sequence”. The “Trig-
ger” button changes to “Sequence” and allows the measurement sequence to be defined. The desired
voltage steps can be entered manually via the panel for the manual sequence or can be calculated for the
automatic sequence after entering the specimen’s ratings.

Additional settings needed are the voltage tolerance between the measured and the desired voltage levels,
the number of values to be triggered at each voltage step, the time to stabilise before conducting any read-
ings, and the period between consecutive values (capture interval) at a fixed voltage step. Once a sequence
is defined, it can be saved and reloaded for future measurements.

Besides recording with a manually defined sequence, the software also offers an automatic sequence mode,
which can be edited, as shown in Figure 34. Here, the required voltage steps are calculated automatically
according to the specimen voltage, which can be set as the phase-to-phase or the phase-to-ground voltage,
and the number of voltage steps.

- ™
g& Define Test Sequence Jf’ _ g
Capture Values at: Woltage Tolerance : E3 20% =
Vottage Rus k1| of Values al Voltage: 3
1. 1.15
2 231 Time To Stabilize Voltage 500 s
3. 346 Capture Interval 15.00 s
4. 462 :
5. —57_4 Mominal Voltage (Phs. - Phs.) <~ 10.00 KV
6. -1.00 Resulting Voltage (Phs. - Ground) 5I7T KV
i 700 g et to Nom Volta [
0. of Steps up to Nom. e
8. -1.00 LB Y : !
g, -1.00 Resulting Step Interval 20.00 % !
— |
0N 00| EndTestat 100.00 % |,
Cancel | ClearList | AddEny | Manual Load ok |
Sequence
—

Figure 34: Automatic sequence wizard

Depending on the high voltage source and frequency, we recommend selecting appropriate values for sta-
bilisation time and capture interval. At power frequencies, a period refresh takes 16-20 milliseconds, while at
very low frequencies a period refresh takes more than 100 seconds. Allow the instrument to complete at least
three refreshes to ensure that accurate and useful data is entered into the table.

pdix.com User guide for ICMflex
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5.5 Display mode settings

Settings affecting individual graphs or measurements can be found in the lower area of the window above the
functional keys. Depending on the graph or area activated (indicated by a dark grey area in the background,
e.g., the graph on the lower left-hand side in Figure 35), different settings will be displayed. To toggle between
the different set-ups, click once with the left mouse button on the area or graph that you intend to modify.

Fle Edit Comnect Options Tools Help

Select relevant chart

Related settings become available

Figure 35: Chart settings

5.5.1 Settings for partial discharge measurement

_of 4 L4 0 S0000 [ 40kHz | 8ODKHz 86 | Unipolar [ Of [ 78 [ VLFOAHz |

PD Auto Gain On/Off The automatic gain adjustment can help to find the best gain set-
ting for the PD measurement path. If the PD signal reaches 95%
of the Y-scale, the software automatically decreases the gain. If
the level drops below 10 %, the gain is increased.

If the PD level is fluctuating widely, it may be useful to disable
automatic mode.

PD Gain 1,2, 4,8,10, 20, The signal amplification can be set manually by selecting a
40, 80, 100, 200, suitable factor from the list. The optimum setting is when the
400, 800, 1024, highest peaks are between 60 and 90 % of full scale.

2048, 4096
Cal Gain 1,2,4,8,10,20, | This entry indicates the gain value set during calibration. This
40, 80, 100, 200, value is modified automatically during calibration and cannot be
400, 800, 1024, set manually.

2048, 4096
Cal Value 1pC-10000 pC This value has to be set according to the PD level used during
calibration.
Highpass 40 kHz, 80 kHz, Depends on the lower cut-off frequency of the PD bandpass
100 kHz filter.
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Lowpass 250 kHz, 600 kHz, | Depends on the upper cut-off frequency of the PD bandpass
800 kHz filter.
LLD 0-100 % LLD stands for Low Level Discriminator. This is the minimum

trigger level for PD pulse acquisition. A level of at least 2 %
should be set to eliminate small noise pulses. The level refers
to the 100 % full scale of the Y-axis of the PD scope and PD
pattern graphs.

Coding Unipolar / Bipolar | PD pulses can be separated by their polarity. “Bipolar” shows
positive and negative pulses separately, whereas “Unipolar”
does not consider the polarity.

Gating On / Off If gating is enabled (On) it is possible to eliminate external noise
pulses. This function is available with all instruments offering an
external “Gate In” connector on the acquisition box. The noise
signal is taken directly from the HV line input on the HV filter. A
special high frequency current transformer must be used.

Gate Level 0-100 % This trigger level determines the sensitivity of the gate input of
the acquisition system. The higher this level is set, the fewer
external pulses will be triggered.

Sync Mode Normal, Normal: The frequency of the applied voltage is calculated
VLF 0.1 Hz, automatically in a range between 20 Hz and 510 Hz.
ﬁ 882 EZ’ VLF: The frequency is set manually to match the frequency
' ‘ setting on the VLF power supply.
Set Time 0..100000 s Pre-set set time for a PD pattern acquisition. The pattern (map)

is stopped automatically after expiration of this time.

5.5.2 Settings for PD fault location

PD Auto Gain FD Gain Cal Gain Calvalue [pc]  Highpass Lowpass LLDx [%] Coding Gating Gate Level [%]  Sync Mode
Off 4 4 5000.0 40 kHz 800 kHz 8.6 Unipalar Off 7.8 WLF 0.1Hz

DSO Auto Gain On / Off The automatic gain adjustment can help find the best gain
setting for the LOC or DSO graph. If the PD signal rises above
95 % of the Y-scale, the software automatically decreases the
gain. If the level drops down below 10 %, the gain is increased.
Automatic voltage adjustment is recommended the normal sync

mode only.
DSO Gain 1,2,4,8,10,20, |Amplification factor for the PD signal in time domain.
40, 80, 100, 200,
400, 800
Trg. level 0-100 % Trigger level for high resolution PD pulses in the time domain
graph.

pdix.com User guide for ICMflex
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Trg. Mode Auto Auto: This mode continuously displays a signal on the
Normal DSO graph (triggered or non-triggered signals).
Single Shot Normal: This mode continuously displays triggered signals
only.
Single Shot: This mode displays a single triggered PD event
and subsequently stops the refresh.
Pre Trigger 1-10 us Time on the DSO graph from zero position to the first trigger.
Scan time 2-320 us Total measurement time for PD signals plotted against time (DSO
graph).
Zoom 2-320 us Zoomed area within the DSO graph. Zooming allows more pre-
cise positioning of the cursors.
Zoom Pos 2-320 us Zero position of the zoomed area.
Cable Len. 10-25000 m Length of the cable under test. This length can be calculated
during calibration or can be pre-set if the exact value is known.
vc [m/us] 100-200 m/us Pulse velocity for PD signals on the MV cable.
vc/2 [m/us] 50-100 m/us

o b 1 b7

5.5.3 Settings for the record mode

U Auto Gain On / Off The automatic gain adjustment can help to find the best gain
setting for the voltage measurement path. If the voltage signal
rises 95 % of the Y-scale, the software automatically decreas-
es the gain. If the level drops down below 10 %, the gain is
increased. Automatic voltage adjustment is recommended the
normal sync mode only.
Gain Usn 1,2,3,4,5,6,7,8, | Amplification factor for the voltage signal from the shunt capaci-
9,10, 11,12, 13, tor on the reference path; Unax = 20 Vpeax
14,15, 16

Gain Usx 1,2,3,4,5,6, 7,8, | Amplification factor for the voltage signal from the shunt capaci-
9,10, 11,12, 13, tor on the test pat; Umnax = 200 Vpeax
14,15, 16

Cn Stored into device | Capacitance value of the reference capacitor. Please check
via configuration your system’s data sheet or read the value as written on the
file grey acquisition box.
i :
=126

Csn Stored into device | Capacitance value of the shunt capacitor of the reference path.
via configuration Please check your system’s data sheet or read the value as
file written on the grey acquisition box.
i :
=126
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Csx (see remark
below)

No limit; to be
calculated before
high voltage is
applied

Capacitance value of the shunt capacitor of the test path.
Please check your system’s data sheet or read the value as
written on the grey acquisition box. With most systems this
value is switchable (ext. jumper) between two ranges, e. g.
40 uF/400 uF

Scaling

Auto / Full Range

Y-axis scaling mode for the voltage graph (left upper corner).
The voltage waveform is scaled to a maximum in “Auto” mode.
The “Full Range” mode sets the maximum of the Y-axis to the
maximum value corresponding to the gain chosen.

Record Mode Manual / Se- This mode is important for the record function. In “Manual”
guence mode, the values in the record table are filled for each manual
trigger event. The “Sequence” mode fills the values into the
table if a pre-set voltage level is reached. The voltage level must
be defined in advance.
X-Axis vs. Time / vs. The record graph in the left lower corner can show values ver-
Voltage sus time or versus voltage.
Sync Mode Normal, Normal: The frequency of the applied voltage is calculated
VLF 0.1 Hz, automatically in a range between 20 Hz and 510 Hz.
x::li 882 EZ' VLF: The frequency is set manually to match the frequency
' ‘ setting on the VLF power supply.
Note:

The setting of the shunt capacitance value for the test circuit Cs depends on the maximum test voltage. The
voltage at the shunt capacitor Csx must not exceed 200 Vpea OF 140 V RMS.

UX (max) = Umax . ny(max)/ Csx < 140 V (')

Please select values for Cs according to the test specimen capacitance and the required maximum test volt-
age (Umax). The shunt capacitor values are stored into the device settings via the configuration file provided
by Power Diagnostix. The actual voltages given by dividers U, and U, can be shown in the voltage display by
selecting Uaeq. Incorrect selection of the shunt capacitor will result in clipping of the sine wave. Please be
aware that U, max must not exceed 20 Vpea (14 V RMS) and Ux,max must not exceed 200 Vpeax (140 V RMS).
Both values are displayed in the top right-hand corner of the voltage measurement chart (see Figure 36).

10.0 < Yems ™ UpeakN2 [~ Upeak LUaqg W
- Un= |78V 47
un [v] W= 180 Ux[v]
50 f= 500 Hz 16.8

00 Wm

-16.8
5.0 | tan ;= 230E.02
COSp = 2.32E.02
e Cx = 89.0nF o
0.0 12.0 [ms] 240

Figure 36: Voltage measurement chart
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5.6 Functions and menus

The ICMflex software offers multiple functions directly from the front panel or via the menu bar at the top of
the screen. These functions vary, depending on the display mode chosen and the hardware options available
with the instrument.

5.6.1 Menu items
5.6.1.1 File

Standard file functions, such as loading and saving files and setting the default directory, can be selected
directly from the “File” menu, as shown in Figure 37. Waveform and/or record exports to an .xls, .xlsx or .html
file can also be selected here. After loading the .flx file, the export will be made automatically.

Eile | Edit Connect Options Tools H
= Load. F4
EH save.. F5
1 Default Directory...
Export Waveform Data... 3
| Export Record... |
Exit F10 | Figure 37: File menu
5.6.1.2 Edit

Edit | Connect Options Tools Help

Adjust Auxiliary Channel
Edit Preferences
Copy Active Graph Ctrl+C
Advanced Settings F1
Standard Report... F2 |
Cable Measurement Report...
Cable Accessories... Figure 38: Edit menu

The “Edit” menu contains the options for copying the active graph to the Windows clipboard. It also offers
access to preferences, advanced settings for the device (see Figure 38), report functions, and options for
cable accessories (see Figure 39).

If the cable is equipped with accessories at a fixed position [ ceble accessory | BB =)
that is known, such as joints, terminations, and cross-link box- Distance [m] — symbol | Color | ]
es, these can be shown as a symbol in the summarising LOC ! 2500 [Joint g e
. A 788.0 Termination B BL
graph. The exact position along the cable length and the de- 3| 3257 |Cross linkBox c | e
sired symbol and colour can be set using the “Cable Accesso- ||+t -~
ries” option. | § 10 B &Y
7 -1.0 B GY
2 -1.0 B GY _'I
Symbol / Character Assignment
A 8 © D
Color/ Character Assignment
| ERD oy mBL Ocy HGR
Dist: ofthe cable ies always refer to the near end!
Set Distance to -1.0 to disable this entry!
Cancel Clear Ok

Figure 39: Cable accessory window
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The software can generate a standard report as ex- |
plained in section 5.6.2.1 and/or a detailed cable
measurement report. The editable options for the de-
tailed report are shown in the screenshot in Fig-
ure 40. In general, the measured data included in the
reports is similar. The differences are mainly various
details concerning the specimen under test, which
can be entered, and the cable accessories at known
positions along the cable length.

o

nE o =

8:20:04

Cosdrter

Goedertier

n
&
2
g
=

Test passed successfully
According to IEEE 4002

iiillllll

<

Figure 40: Cable measurement report window

General settings, such as interface and report language,
display resolution, or the type of window labelling can be
made in the “Preferences” window.

‘Record Charge Weighting” determines wheth-
er the charge weighting follows IEC 60270 (Qiec) or
IEC 60034-27-1 (Qm).

“Record PD/inc/ext voltage” enables/disables recording
of the inception/extinction voltage.

“Activate TCP Server” enables/disables the ICMflex con-
trol software’s built-in TCP server, which allows third-par-
ty programs to access measured values. Connection to
the TCP server can be established using the computer’s
IP address and the port specified in the preferences.

Enabled

XGA (1024 x 768)

English

English

=
=1

Standard

QiecWeighting

Bipol

elyy old
.

Figure 41: General preferences windows
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5.6.1.3 Connect

Connection of the software to the ICMflex can be established by using the F6 function key, with the menu
option as shown in Figure 42, or by pressing the “Search” button in the key bar.

| Connect | Options Toc
i = Search F& l

Figure 42: Connect menu

5.6.1.4 Options

The “Options” menu (Figure 43) mostly offers settings for the various charts. In addition, the language, dis-
play resolution, and the interface settings, as explained in section 5.2, can be selected.

| Options | Tools Help
Record Graph vs. Time

| Display Mode
Language

Report Language
Display Resoluton
Stripchat Options

* v w w w ¥

Figure 43: Options menu

5.6.1.5 Tools

The “Tools” menu (see Figure 44) shows the device information (see Figure 28).
| Tools | Help

Figure 44: Tools menu

Help

The “About” item of the “Help” menu (Figure 45) gives information about the installed software release as
shown in Figure 46. For further questions regarding the device, the Power Diagnostix contact details are given.

| Help |

| Index...
[ fbout.. |

Figure 45: Help menu

Figure 46: ‘About’ window
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5.6.2 Function keys

All main functions are shown at the bottom of the window (see figure below). Some buttons cover multiple
functions depending on the display mode of the software.

e [eme [ o [ oo [ o [ e oo e | o | o]

Figure 47: Function keys at the bottom of the application window

5.6.2.1 Report [F1]

Pressing this button will open the pop-up window shown in Fig-

ure 48. Here, it is possible to fill out a standard report with brief in-
formation regarding the measurements made. This set of informa-
tion is saved with each ICMflex file (*.flx) and is available after
loading files from the hard drive or SSD. It will appear on most
printouts and with all exported data, like .html or xIs(x) files. The
live charts required for the report can be selected with the tick box-

es at the bottom of the panel. Note that the charts used in the re- il
ports are always the current charts. Goedertier

TestPassed Succesfully

KUY Y
q

Figure 48: Standard report
5.6.2.2 Calibrate [F2]

The “Calibrate” function can be used to calibrate either the PD amplitude or the cable length of an MV cable
under test. To calibrate the PD amplitude, it is necessary to activate the PD scope display (graph on the upper
right) or the PD pattern display (graph on the lower right). Pressing the “Calibrate” [F2] button in this mode will
open a pop-up window where the exact PD calibration value must be entered. This value is equal to the value
displayed on the PD calibrator (CAL1A or CAL1B). Please check the correct connection of the PD calibrator,
the correct gain setting, and the PD pulse on the PD scope display before calibrating. Further explanation is
given in the application notes in sections 6.1.2 and 6.2.2. The length of an MV cable can be calibrated by first
activating the DSO display (lower left graph). Check the reflections of PD pulses on the graph and set cursor
R and cursor 2 to the first and the second pulse. After pressing the button “Calibrate” the software automati-
cally calculates the pulse velocity of the PD pulses.

5.6.2.3 Copy [F3]

This helpful tool copies graphs to the Windows clipboard. Pressing this button will place a copy of the activat-
ed graph (panel with dark grey background) into the clipboard, from where it can be pasted into documents
in other applications.
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5.6.2.4 Load [F4]

This function is available only when the software is not connected to an instrument. It allows old measure-
ments to be loaded from a hard disc or other memory. Files saved with the ICMflex software have the file suffix
* flx. This file somprises all measurement data, settings, and reports. To restore typical settings, it is helpful
to save some default files for standard set-ups for cables and rotating machines.

5.6.2.5 Save [F5]

In all modes, it is possible to save *.flx files. Old files can be loaded, modified, and saved again. Running
measurements can be saved at any time. The saved file consists of all measurement data, settings, and re-
ports.

5.6.2.6 Search/Offline [F6]

To connect the ICMflex software to an instrument, press the “Search” button. If the COM port settings and the
cabling are correct and the instrument is turned on, a pop-up window will show the message “ICMflex found
at COM xy”. This message will disappear automatically after a few seconds. To disconnect the communica-
tion line, press the same button again. While online, this button is labelled “Offline”. While offline, the button
is labelled “Search”.

5.6.2.7 Start Rec / Stop Rec [F7]

This button is used to start a recording of values vs. time. Switch to the TD display mode to see all values
recorded in the corresponding graph and in the table. This function has to be started and stopped manually
by pressing the F7 button.

5.6.2.8 Start Map/Stop Map [F8]

Use this button to start PD pattern acquisition. The pattern is shown in the graph on the lower. The measure-
ment is stopped automatically at the end of the pre-set “Set Time”. It can also be stopped by pressing the F8
button again.

5.6.2.9 Print [F9]
This button sends the active graph to the default printer.
5.6.2.10 Exit

Close the program by pressing this button.
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5.7 ICMflex and PD calibration
5.7.1 Calibrators

There is a broad range of impulse generators offered by Power Diagnostix for different purposes. The table
below gives an overview of these. All allow the calibration of PD measurements according to IEC 60270/2000,
except the CAL2B/C/D, since these models are not equipped with an injection capacitor to enable calibration
on GIS. For the ICMflex’s applications, the most common calibrators used are the CAL1B for on-site testing
and CAL1A for laboratory purposes.

CAL1A 1,2,5,10, 20, 50, 100 pC Injection capacitor <1 pF 50 Hz (60 Hz)
CAL1B 100, 200, 500 pC, 1,2,5,10nC Injection capacitor <100 pF | 50 Hz (60 Hz)
CAL1C 1,2,5,10, 20, 50, 100 pC* at 100 pF | Voltage output (50 Q) 50 Hz (60 Hz)
CAL1D 10, 20, 50, 100, 200, 500, 1000 pC Injection capacitor <10 pF | 50 Hz (60 Hz)
CAL1E 0.5,1,2,5,10, 20, 50 nC Injection capacitor <500 pF |50 Hz (60 Hz)
CAL1F 0.2,0.5,1,2,5 10,20 nC Injection capacitor <200 pF | 50 Hz (60 Hz)
CAL1G 0.02,0.05,0.1,0.2,0.5,1,2nC Injection capacitor <20 pF | 50 Hz (60 Hz)
CAL1H 0.5,1,2,5,10, 20, 50 pC* at **pF Voltage output (50 Q) 50 Hz (60 Hz)
10, 20, 50, 100, 200, 500, 1000 pC* at 100 pF
CAL1J Voltage output (50 Q) 50 Hz (60 Hz)
100, 200, 500, 1000, 2000, 5000, 10000 pC* at 1 nF
CAL2B 2,5,10, 20, 30, 40, 50 V (into RL=50 Q) Voltage output (50 Q) 50 Hz (60 Hz)
CAL2C 1,2,5,7,10,12,15,17,20 V (nto RL=50 Q) | Voltage output (50 Q) 50 Hz (60 Hz)
CAL2D 5,7.5,10, 15, 20, 30, 40 V (nto RL=50 Q) | Voltage output (50 Q) 50 Hz (60 Hz)

*with external high voltage capacitor, ** value to be specified by customer
Table 1: Calibrator overview

As an example, a type CAL1A calibrator is shown in Figure 49. All calibrators are switched on with the “On/
Off” button. Both amplitude (Range) and polarity (Pos/Neg) of the single charge pulse per cycle are displayed
and can be adjusted by pressing the two buttons. The instrument is synchronised to line frequency by a pho-
todiode. In case of insufficient pick-up of power frequency light, it will automatically select the internal quartz
oscillator (50 Hz and 60 Hz versions available). The “On/Off” button must be pressed for more than one sec-
ond to switch the pulse generator off, while automatic switch-off occurs after approximately 15 min. Operation
time of up to 200 hours is possible with the 9 V lithium battery as the average supply current is approximately
5 mA (quiescent current is negligible). An alkaline battery may be used in place of the lithium
battery and will give around 90 hours of continuous operation may replace the lithium bat-
tery. A weak battery is indicated by the “LO BAT” sign of the LC display.

Warning: While changing the battery, be aware of internal parts carrying up to 125 V DC!

Figure 49: CAL1A
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Power Diagnostix delivers its standard calibrators with a fully traceable DAKkS calibration certificate
(DK150680100). This calibration certificate documents traceability according to national standards, which
fulfil the units of measurement according to the International System of Units SI. The DAKKS (Deutsche
Akkreditierungsstelle) is a signatory to the multilateral agreement of the European co-operation for Accredi-
tation (EA) for the mutual recognition of calibration certificates.

Before attaching the calibrator, make sure that the object under test is de-energised. The inner conductor of
the BNC/banana adapter must be connected to the test specimen’s conductor. The outer (ground) connector
has to be connected with the solid grounding of the test object. Ensure that ground leads between the cali-
brator and the ground shield are as short as possible. Care must be taken that the calibrator is isolated from
the HV part of the ICMflex.

s 5.83 =
Q, = 491nC f= 500Hz nas-zmama e 7 1005 . .
oy [ Q™ 807G O e Calibration pulse
PiCllq . = 47.910C P s

00 -

} Noise level

415

0 1800 [deg] 360.0 0.0 180.0 Ideg] 2600

Figure 50: Calibration pulse scope display Figure 51: Calibration pulse PD pattern

The charge level to be injected into the measurement circuit depends on the cable length, stator winding
or bar capacitance (attenuation), and background noise conditions. It's important to have a good signal-to-
noise ratio to ensure a sufficient sensitivity. Choose a value approximately five to ten times higher than the
present background noise. Typical values used for on-site testing vary from 200 pC to 5 nC, even 10 nC in
the case of very long cable lengths or large turbo generators.

Once the injection value is selected, the calibration pulse can be observed with the ICMflex software. Calibra-
tion of the apparent charge is supported by the two charts on the right of the PD mode display. The upper left
chart represents the calibration pulse as scope like pulse pattern (two-dimensional, compare Figure 50) while
the upper right one plots the pulse into an ¢-g-n related pattern (three-dimensional as shown in Figure 51).
Adjust the PD gain settings so that the calibration pulse fills 60-90 % of the maximum current amplitude. Also,
select the appropriate SYNC setting during calibration, CAL50Hz or CAL60Hz, even if VLF is used. Using the
same settings for VLF, speeds up the screen refresh. Select a value for the low level discriminator such that
the background noise can still be observed. Don't forget to switch off the gating function during calibration.

Calibration can be performed by a double click on the highest pulse
shown in the scope-like display or by a double click on the correspond-
ing upper line in the phase resolved PD pattern. Thereafter, the calibra-
tion pop-up (Figure 52) will ask for the value of calibration charge. Once
this is entered, compensation of the attenuation of the complete circuit
will be done automatically. Please bear in mind that the calibration is
valid for one bandwidth and one specific test set-up only. Hardware
and/or software changes require a new calibration. Don't forget to save |3
the calibration file! Figure 52: Calibration charge pop-up
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Ensure that the selected unit [pC/nC] and amplitude are suitable for the injected charge. For further informa-
tion about calibration, please see sections 6.1.2 and 6.2.2.

® Always provide solid grounding of the instrument and the filter units

Warning

® Make sure that the cable/machine is de-energised before calibration.

5.8 Gating
5.8.1 Principle of operation

Effective noise reduction is required when the ICMflex is used for measurements in an environment where
high frequency (HF) electrical noise is present. HF disturbances that hamper partial discharge detection but
can be mitigated by the gating function include frequency converter switching pulses, corona discharge, and
thyristor firing, provided those signals from the noise source are picked up by an antenna or another sensor.
Using the analogue gating function cuts out this impulse noise. With some applications, a current transform-
er (CT) is used to acquire the disturbance signal from a ground conductor or from the screen of a signal ca-
ble. Some electronically controlled resonant test sets provide a TTL signal for switching purposes.

5.8.2 Analogue gating

The standard ICMflex comes with a “GATE IN” terminal for a BNC cable that transmits a gating signal from
an HV filter with a built-in current transformer. The gate level is set by using the ICMflex software (see sec-
tion 5.5.1). This option is mainly used for VLF cable testing.

Caution: The analogue gating input of the ICMflex is intended exclusively for connection to an HV filter! Never
connect another device to this input as this may cause serious damage to the equipment.

When using the gating function in the ICMflex, disturbance signals from the HV line are detected by the high
frequency current transformer (HFCT) embedded in the high voltage filter (T50/1 or equivalent). The output

Analogue
GATE IN

Figure 53: Gating Inputs

of the HFCT should be connected to the “GATE IN” BNC terminal of the ICMflex shown in Figure 53. In the
instrument, a built-in preamplifier takes care of signal conditioning. The bandwidth for the gating signal is
internally set from 2 to 20 MHz. Analogue gating can be activated in the software in the PD Mode (gating on).
The gating threshold in percent (gating sensitivity) must be set according to the level of the disturbance puls-
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es. The gate level in percent refers to the maximum scale of the PD pattern or PD scope view at the particular
gain. To adjust the gate level to blind out the switching pulses of the VLF for instance, the general background
noise must be investigated; the low level discriminator (LLD) level should be set to the peak value of the over-
all ambient noise. As soon as the LLD level (peak value of the ambient noise) is known, the gate level can be
selected at a level above the LLD level to avoid excessive gating times. As soon as the instrument is gating
effectively, the corresponding gating time is shown in the PD scope graph (upper graph on the right in PD
mode). The gate time in percent refers to the time the instrument gates during one full cycle.

Example:

With 0.1 Hz, one cycle is 10 s, if the gate time is 30 %, gating has been active for 3 s.

1.22

122 Qp 692pC Gate Time= 7% f= 0.10Hz
Qgug= 720pC

QplaCllq, = 4s1pC

Qp [nC]

0.0 {4 0.0 m ” 1 -
122 gl
0 1800 [deg) 360.0 Y ik ldeq] S2
Figure 54: PD and VLF switching pulses Figure 55: Switching pulses effectively gated

In the example shown in Figure 54 and Figure 55, the LLD level was 5 % and the gating threshold was set to
8 %, resulting in a gating time of 7 %, i.e., 0.7 s with a sine wave of 0.1 Hz.

Try to reduce the gate time below 30 % so as not to lose significant PD pulses. In other words, don't set the
gating sensitivity too low so that the gate time exceeds 30 to 50 %. Ambient noise other than the switching
pulses of the VLF, transformer, or rack transfer switch is not blocked using analogue gating. To deal with
other kinds of disturbances, fibre optic gating using the GST1 and a current transformer is available (see
section 7.3).
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6 Application notes

The application notes for medium and high voltage cables, rotating machines, and single stator bars de-
scribe the measurement set-up, calibration, step by step procedure for performing the measurement, soft-
ware usage, and evaluation criteria according to the relevant standards.

6.1 Medium and high voltage cables
6.1.1 Measurement set-up

A general description of the measurement set-up is given in section 3, but here, the focus is on medium
voltage (MV) and high voltage (HV) voltage cable applications. The order of connecting the various links is
shown in Figure 56. Most important is the interconnection between the main grounding of the high voltage
supply and the cable ground shield (1-3). The final link from the grounded baseplate of the ICMflex to the
ground shield must be as short as possible (3). The HV output cable of the ICMflex must be connected to the
inner conductor or termination (6).

6.1.2 Calibration

Performing HV tests including partial discharge (PD) measurements and PD fault location on cables, requires
calibration of both the apparent charge and the cable length. When the safety procedure detailed in sec-
tion 1.3 has been completed and the set-up has been carried out as described above, calibration can be
performed. General procedures are described in the Power Diagnostix’s user manual for calibration impulse
generators. However, the detailed calibration procedure for cable fault location is explained below.

Since a test specimen has a capacitance against the ground shield, which for medium and high voltage ca-
bles ranges from 200 pF/m to 425 pF/m, the cable capacitance will strongly attenuate of the injected pulse.
The difference between the injected and measured Qp level is the k factor, the overall attenuation factor of the
complete test circuit. The Kk factor has to be compensated for by the calibration.

HY Filter 1CMifex
Quter Shield (6)
(5)
*
(3)
High Yoltage Supply 1
\e/LgF System, ! (1 )
Transfarmer,
Resonant Test System, ]
(2)

GND

Figure 56: MV cable measurement set-up
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Figure 57: CAL1B connected to MV cable (lab) Figure 58: CAL1B connected to MV cable (on-site)

Common calibration levels for laboratory acceptance tests are in the range 2 to10 pC (CAL1A). However, for
on-site testing, it is often not possible to use calibration as sensitive as in the laboratory. Due to this, calibra-
tion is often made with injection levels from 100 pC to 2 nC (CAL1B).

In additional to the calibration of the apparent charge in accordance with IEC 60270, the cable length or pulse
velocity has to be calibrated for performing PD fault location (time domain reflectometry (TDR)). At least one
of the two values must be known in advance. Table 2 lists some typical values for the velocity of propagation
in relation to the cable insulation type. Note that these values can vary, depending on the nominal voltage and
dielectric strength. The cable supplier usually provides the exact values with the cable data.

XLPE 147-168 73-84
PILC 147 73
EPR 165 82
Vacuum 300 150

Table 2: Pulse velocity factors

The injection principle is the same as for the calibration of the apparent charge. A higher charge level may be
required to see the necessary reflections for the TDR. Often a pulse magnitude of 5 or even 10 nC is required.
If the injected calibration pulse is not visible in the digital storage oscilloscope (DSO) screen, increase the
value of “DSO Gain”, until the pulse becomes visible. It is also important to choose a sufficiently high trigger
value to avoid triggering on disturbance levels. Along with the DSO gain and trigger level, adjust the timebase
(X-axis) to ensure that the reflections are visible.

For calibration of the cable length, the cable terminations must be disconnected on both sides for a full reflec-
tion of the signal at an infinite impedance. Check the cable set-up carefully before calibrating.
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¥1= 11.06us
¥2= 539us
x12= -567us

Figure 59: Cable with shorted end

¥1= 112%us
w2= S5.44us
2= -585us |

x1= 9517m
¥2= 4583m
¥12= -4934m

Figure 60: Cable with open end

The DSO screen in Figure 59 shows the first two reflections arriving at the measuring impedance. Since the
cable has an open end, the time difference between the reference pulse and its first reflection represents
twice the cable length. The factor of 2 is automatically computed and must not be taken into account sepa-
rately. The DSO screen in Figure 60 shows the result with a shorted cable. Here, the second reflection shows
a polarity change due to the negative reflection factor. Check both ends in such a case.

For the calibration of the cable length as shown in Figure 61 it is important to consider the following param-

eters:

® DSO gain : The reference pulse must fill 60-90 % of the maximum scale

® Triggerlevel  : Must be set sufficiently high not to trigger on disturbance pulses

® Scantime : Adjust according to the cable length to achieve the best sensitivity (0-320 us)
® /oom : Use the zoom function to position the cursors more accurately

® Zoom position : Sets the start position of the zoom function with reference to the X-axis

The black cursor (R) must be placed at the be-

ginning of the reference pulse; the blue cursor
(2) must be placed at the beginning of the first |

reflection. If the cable length is known, the “Cal-
ibrate” button at the bottom of the window can
be pressed. The software will for the cable length
to be entered. In cases where the pulse velocity
is known, the value must be set for pulse veloc-
ity Vc. When the pulse velocity is known and
both cursors are set correctly, x2 will show the
cable length. The more accurate the cursor po-
sitions are, the more accurate the distances cal-
culated will be. We recommend saving the file.

88 Power Diagnostix - ICMfiex =)
Hel

Figure 61: Cable length calibration
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6.1.3 Standard PD measurement

Once the calibration procedure is completed and the calibrator has been removed from the test specimen,
the voltage may be switched on. Pay attention to the correct setting for the shunt capacitor Csx (low or high)
as explained in section 5.5.3.

Before switching on the voltage, it is important to observe the background noise level. Adjust the PD gain
and LLD level so that the maximum of the background noise is still visible. Do not set the LLD level down to
0 %, as this will mean that the A/D converter is occupied converting background noise pulses. Masking the
background noise up to 80 % of its maximum amplitude is acceptable.

After switching on the voltage, additional noise cancellation may be required to get rid of disturbances caused
by the power supply itself or by external sources. This can be done by using the gating option, either with
analogue gating or gating via a fibre optic gating transmitter. See sections 5.8 and 7.3 for more information.

The next step is finding the partial discharge inception voltage level. Clearly, before reaching the partial
discharge inception voltage (PDIV), no root cause analysis or PD location investigation using time domain
reflectometry can be performed. According to IEEE 400-3, for instance, a healthy cable will not show any sign
of partial discharge activity at voltage levels lower than 2 Un.

Once the inception voltage is reached, the PD pattern can be mapped and compared with typical phase
resolved pattern from known PD origins (see section 6.1.7). Besides the pattern, the related discharge levels
(Qp, QIEC) and the average discharge current (NQS) are given. Pay attention to the correct settings of PD
gain and LLD level. Adjust the gain value until the PD pulse amplitude is between 50-90 % of the maximum
scale as shown in Figure 62 and Figure 63. The first line analysis of the nature, cause, or PD origin can be
made using the pattern. The location along the cable length must be determined using time domain reflec-
tometry. Typical times for mapping the phase resolved pattern are 30 to 60 seconds for power frequency and
about 500 to 1000 seconds for VLF at 0.1 Hz.

"o, =119c f=501Hz 177 nos = 182 s N= 78062 3335
Qiec= 9.26nC -

atx.y)f:,—.zsmé_\‘\\
QpCl -
|

Qp [nC] a

89

oo [nMMARN o020 oNNN .| 0| e g :
0 180.0 [deg] 3600 0.0 180.0 [ded] 360.0
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6.1.4 PD measurements on cables with high capacitance

For PD measurements on specimens with high capacitance, Power Diagnostix
provides the CSX900 extension box (Figure 64) which extends the Csx value of
the ICMflex to 900 uF. The box is mounted onto an isolator of predefined height
according to the maximum voltage level of the VLF source.

The following figure shows the set-up when using the CSX900 box.

ICMflex

Capacitance range -
jumper plugged in T

female

HV Filter

O 4 0O
GND -
4 Figure 64: Extension box CSX900
4
24
f CSX900
f - L4
é O s O o\ W male
GND female .
| 1 \ . P A female e — Outer Shield
- é ‘male
! \ é \
High Voltage Supply
1 N 1
e.g.
VLF System, | S 4
Transformer, LS cx V4
Resonant Test System, 1 ~ (4 ’
[E— - . o= GND™ g » ™ = =

GND
Figure 65: Measurement set-up with CSX900 extension box for specimen with high capacitances

Warning: The ICMflex contains a shunt capacitor Csx, located between the two MC connectors, which can
retain charge that is potentially harmful or fatal to users. To fully discharge Csx, the ICMflex must be grounded
at both the input and output sides. Grounding the voltage source is not sufficient to ground the test object. If
only the test object is grounded and the voltage source does not provide a permanent grounding connection,
the potential of the ICMflex input connector will only be shifted such that the charge remains and poses a
hazard to users.
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6.1.5 PD fault location

When the PD pattern has been mapped and saved and the required notes are made, attention should be
given to the DSO. Here, each partial discharge pulse is represented on a time-based curve. First, the settings
must be adjusted so that the reference pulse and the two first reflections arriving at the coupling unit are vis-
ible on the screen, as explained in section 5.4.2.

Once partial discharge activity has initiated, the DSO can be used for estimating the PD location.

When the DSO settings (such as the DSO gain, trigger level, scan time, zoom, and zoom position) are opti-
mised so that the reference pulse and the first as well as the second reflection are clearly visible on the DSO
screen, the scan procedure may be started. While scanning, snapshots will be taken of pulses that exceed
the trigger level. It is important to select a trigger level that avoids triggering on disturbance signals. After
pressing the “Scan” button in the DSO menu, the pop-up screen for scan settings will appear (Figure 66).

Select the required data directory for saving scan files

Enter the maximum number of scan files (up to 1000) gsanserings [N
Data Directory
clusers\goederiendeskiopl

Enter the name of the phase under test ax File Number -

-

Enter the file prefix, useful for later analysis Phase S Phaset

°
)
® Select phase (1, 2, or 3)
°
°
°

Name of Phase H

If non-triggered snapshots are also needed, select the corre-
sponding option File Prefix 15_kv

Scan non triggered r

® To start the scan, press “OK”

After the scan is finished, the PD location can be pinpointed. Go of- Eeeeemaeeee——————————
fline with the software and run the “Start Replay” function from the function keys at the bottom of the window.

Here, you can evaluate the scan files manually. [ EnEoEY =
First, the software asks you to select the folder | oreeer e, ~
where the scan files are stored. Looki [ Scan 5] emm-
':' < EH13_b-m_U_000.tdr EH13_b-m_U_001.tdr
Once you have chosen the relevant folder, you - ATy o
can select the .tdr files to be evaluated. After : EH13 b-m_U_004.10r EH13_b-m_U_00S.1dr
. . . “ N -J EH13_b-m_U_006.tdr EH13_b-m_U_007.tdr
selecting the files and pressing the “Add” but- Deskiop EH13 b-m_U_0081dr EH13_b-m_U_009.tdr
: : = EH13_b-m_U_010.tdr EH13_b-m_U_011.tdr
ton, the files you have chosen will be shown u:“En-Js iy e
in the selection box (see Figure 67). To con- P EHL3.b-m U 0141dr EH13 b-m_U_015.1dr
. . . . N k EH13_b-m_U_016.tdr EH13_b-m_U_017.tdr
firm that these are the correct files, click “OK”. Computer EHL3_b-m_U_018:1dr EH13_b-m_U_019tdr
H H ) EH13_b-m_U_020.tdr EH13_b-m_U_021.tdr
The software will automatically open the replay ﬁ; e L3 o U023
function. i EH13_b-m_U_024.tdr
File name [ ~| add |
Files oftype: I (™dr) LI Cancel
Selected Files:
oK
Remove
Remove All
y:
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The main task when using the replay function is the correct [&gRreplay
positioning of the cursor for the reference pulse (grey cursor (Lo praTe oo 1 (0N Suwn e AU A
in Figure 68) and the cursor for the first reflection arriving at -
the coupling capacitor (green cursor). The file name of the
current .tdr file is displayed above the diagram.

Below the diagram are text boxes indicating the distance | “*1** VNMWWWWWMM«W

between the cursors, the time delay between the two puls-
es, the voltage level at which the files were recorded, and
the related Qp level for the file.

Imv]

AEE T T T T
10 2.0 7.0 1.0 16.0 [us]19.0

a1 4601 m [ at 546us ] (2 00KV Qp 127.4pC
Save Delete o Select |}
Cancel File As File Back Skip Al i Select

Figure 68: Replay screen

In the bottom part of the replay screen (Figure 68), you will find these buttons:

® Cancel: For stopping the current replay

® Save File As: For storing the current file

® Delete File:  For removing the file from the selection

® Back: For returning to the previous file

® Skip: For switching to the next file

® Select All: For adding all files into the LOC screen

® Select: For adding the current file into the LOC screen

After you have positioned the cursors for the reference pulse and first reflection, you can use “Select” to add
the position of the PD activity along the cable to the summarising LOC diagram. When scan files are validated
and result in identical positions along the cable, the result of each single event will be added and shown as
the total amplitude in the red bar, as shown in Figure 69. The PD amplitude refers to the peak discharge level
at the time of scanning and does not indicate the PD amplitude at the position of occurrence.

With the check box “Loc Grid”, it is possible to switch on grid lines within the LOC chart. With the option “Pro-

jections”, you can enable cursors in the LOC chart. The s 7 LECG =
' i ic indi = B - om |10

mapping reference, i.e., near or far end, is indicated by the | pey |ras scenn ae pomiE

coupler symbol on the X-axis. P3= (00m Ci2= | 00m

120

=
A ..
=)

[m] T00
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6.1.6 Test voltage recommendations and criteria

The relevant standards for medium and high voltage cable testing describe test voltages, sequences, and PD
evaluation criteria in relation to the cable’s voltage class. Select the test type to be performed, i.e., acceptance
testing or on-site testing. On-site testing is mostly performed after installation tests and is recommended to
verify the performance of cable accessories, such as joints and end terminations, which are often installed
on-site. Table 3 shows the recommendations given in the relevant IEC standards.

Standard \ Frequency \Voltage \ PD Criteria \ Frequency \Voltage \ PD Criteria
1kV <U<40kV
IEC 60502 |49-61Hz |3.5Uy/5 min |1.73 Uy < 49-61 Hz 1.73 Uo/5 min None
10 pC 49-61 Hz Uo/24h
DC 4 Uo/15 min
40 kV < U < 150 kV
IEC 60840 49-61Hz |25 Uy/30 min | No PD 20-300Hz [1.73-2 Uy/1 h None
up to 1.5 UO 49-61 Hz Uo/24 h
150 kV < U < 500 kV
[EC 62067 |49-61Hz [25Uy/30min |1.5U, < 10pC |20-300Hz |1.1-1.73 Us/1 h | None
2.5 Uo/60 min 49-61 Hz Uo/24 h

Table 3: MV cable test voltages

As can be seen from Table 3 , no PD criteria are given for on-site testing. Shielded test room conditions
cannot be compared with on-site conditions. The main reason is the set-up sensitivity which is often critical
because of the background noise. In shielded test rooms background noise levels of less than 2 pC can be
achieved and in these cases, specifying criteria makes sense. With on-site testing, background noise from
a few tens up to hundred pC is not unusual. In this case, it is important to build a well-considered partial dis-
charge free test set-up and to perform sufficient sensitivity checks at all available positions in order to gain
a better understanding of the partial discharge’s high frequency signal transfer within a certain bandwidth.
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As well as the IEC standards, there are applicable IEEE publications. The general procedures and criteria
do not differ much from those prescribed by the IEC. However, of interest in the IEEE standards are the test
voltage criteria for testing at very low frequency (VLF). The IEEE splits cable testing into three different groups:
installation test, acceptance test and maintenance test, each with related test voltages.

KV RMS KVRMS | kVpeak | KVRMS | kVpeak | kVRMS | KV peak
5 9 13 10 14 7 10
8 11 16 13 18 10 14
15 19 27 21 30 16 22
3 20 24 34 26 37 20 28
2 25 29 41 32 45 24 34
= 28 32 45 36 51 27 38
30 34 48 38 54 29 41
35 29 55 44 62 33 47
46 51 72 57 81 43 61
69 75 106 84 119 63 89

Table 4: MV cable VLF test voltage recommendations

In general, the recommended testing time according to IEEE 400.2, varies between 15 and 60 minutes.
30 minutes is suggested. For maintenance testing, 15 minutes is recommended.
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6.1.7 Typical PD patterns and tan delta levels
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MV class cables are tested in the factory in accordance with common IEC standards. The acceptance lev-
el for new cable systems is < 2 pC. Therefore, all PD detected on MV cables under applied voltage up to
1.5 x rated voltage should be considered as a problem within the cable or its accessories. Further analysis

should clarify the cause of this PD activity.

silicon fat due to improper
mounting procedure

Void discharge <2 pC >20 pC

[nC]
with low availability of
starting electrons 0

" a 180 [deg] 360
Surface discharge <2 pC >20 pC 523

.-’/ﬁ\\‘—.

[nc
Internal discharges in a <2 pC >20 pC
prefabricated EPR cable
joint

e a - 180 — } [.d-E-g] - 360
Several flat cavities in <2pC >20 pC 200

[nci

0.0

0 130 [deg) 360

Table 5: Typical PD patterns for MV cables
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The loss factor values measured on MV cables are usually specified in relation to the cable insulation system
and voltage level Uy, 2 U, or the tip-up between 2 Uy and Uy. Pay attention to the environmental conditions as
they strongly influence loss factor and capacitance measurements. Indicative TD values are given in Table 6.

XLPE <0.1x10° ~12x10% > 22x10%
EPR <35x10° > 3.5x10° -
PVC < 6x 107 (50 Hz) > 6x 102 (50 Hz) -

< 8x102 (0.1 Hz) > 8x102 (0.1 Hz)

Table 6: Tan delta levels versus insulation system

6.1.8 Normative references

IEC 60502:

IEC 60840:

IEC 62067:

IEEE 400:

|[EEE 400.2:

|IEEE 400.3:

Power cables with extruded insulation and their accessories for rated voltages from 1 kV
(Unm = 1.2KkV) up to 30 kV (Un, = 36 kV)

Power cables with extruded insulation and their accessories for rated voltages above 30 kV
(Un = 36 kV) up to 150 kV (Un, = 170 kV) — Test methods and requirements

Power cables with extruded insulation and their accessories for rated voltages above 150 kV
(Un = 170 kV) up to 500 kV (U, = 550 kV) — Test methods and requirements

IEEE Guide for Field Testing and Evaluation of the Insulation of Shielded Power Cable Systems
Rated 5 kV and Above

|IEEE Guide for Field Testing of Shielded Power Cable Systems Using Very Low Frequency (VLF)
(less than 1 Hz)

|[EEE Guide for Partial Discharge Testing of Shielded Power Cable Systems in a Field Environment

pdix.com
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6.2 Rotating machines
6.2.1 Test set-up

A general description of the measurement set-up is given in section 3, but here, the focus is on rotating ma-
chines applications. Most important is the interconnection between the main grounding of the high voltage
power supply, i.e., a transformer or resonance test set, and the main grounding of the machine frame. The
final link from the grounded baseplate of the ICMflex to the ground shield must be as short as possible. The
high voltage output cable of the ICMflex has to be connected to the phase terminals of the motor or generator.
Figure 70 shows the connections for a typical set-up.

HV Filter [CMflex
é ------------------------ (6)
female E
(5)
- N o wm o o w
(3)
High Voltage Supply Y
eq. (]
YLF System, (1) @
Transfarmer,
Resaonant Test System, I
I:I s
-
GND

Figure 70: Rotating machines measurement set-up

6.2.2 Calibration

Performing high voltage tests, including partial discharge measurements on rotating machines insulation
systems in accordance with |[EC 60270, requires calibration of the apparent charge. When the complete
safety procedure as detailed in section 1.3 has been completed and when the set-up has been arranged as
described above, calibration can be performed. General procedures are described in the Power Diagnostix
user manual for calibration impulse generators. The detailed calibration procedure for generators and motors
is explained below.

A calibrator is connected to the phase terminal that is connected to the ICMflex as shown in Figure 71. The se-
lection of the charge level to be injected into the measurement circuit depends on the machine’s ratings. The
main parameter influencing the required charge is the stator winding capacitance. In general, the capacitance
depends on the nominal voltage, number of poles, and the core length. It is important to have a reasonable
signal-to-noise ratio to ensure sufficient sensitivity. Select a value that is approximately 5 to 10 times higher
than the background noise present. Typical values used for on-site testing range from 1 nC to 5 nC, and even
10 nC for hydro or turbo generators.

User guide for ICMflex pdix.com




ICMflex
Partial discharge and loss factor measurement system

It is recommended also to make a calibration using the PD attenuator. Due to the properties of the insulation
materials and the winding manufacturing techniques in an epoxy mica insulation system, partial discharge
pulses can reach large amplitudes. In regular mode, the amplifier may not be able to handle these unusually
large pulses. For this reason, the ICMflex has an on-board 10 dB attenuator, which can be activated in the
advanced settings. It is possible to activate the attenuator and upload the relevant calibration file without inter-
rupting the measurement session. The PD attenuator can be switched on using the menu item “Edit”->"Ad-
vanced Settings” of the ICMflex software.

If access to the neutral connection (star point) is possible, the phases can also be tested separately. In this
case, it is necessary to carry out additional calibration as the capacitance to ground will be different. Further-
more, injecting a pulse at the neutral terminal and measuring the response at the line terminal gives a good
idea of measurement sensitivity.

Figure 71: Calibration on a small asynchronous motor

- pr-

Figure 72: Calibration on a synchronous generator

6.2.3 PD measurements

After the calibration procedure has been completed and the calibrator (CAL1) has been removed from the
test specimen, the voltage may be switched on. Pay attention to the correct setting of the shunt capacitor Cy
(low or high) as mentioned in section 5.5.83.

Before applying voltage, it is important to check the level of background noise present. Adjust the PD gain
and LLD level so that the PD amplitude is 50-90 % of the maximum scale and the maximum of the back-
ground noise is still visible. Do not set the LLD level down to 0 %, as this will mean that the A/D converter is
occupied converting background noise pulses. Masking the background noise up to 80 % of its maximum
amplitude is acceptable.

After switching on the voltage, additional noise cancellation might be required to get rid of disturbances caused by
the power supply itself or by external sources. Use the gating option for this purpose. Analogue gating and gating
via a fibre optic gating transmitter are possible. Please see sections 5.8 and 7.3 for more information.
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The next step of the measurement process is
identification of the partial discharge inception 4:}%?,
voltage (Pov). A sensitive abd slow ramp up of |apme)
the test voltage is important for determining the [TEIES]
Pow. A typical test sequence used for partial dis-

charge measurements is, for instance, the same 2“-5‘:_‘8
as that for tan delta measurements. An exemple
is shown in Figure 73. In this case, the test volt-
age must be increased in five equal steps, each
20 % of Uyax up to a maximum of Uupax. The max- .00

imum voltage level (Uvax) applied to ground is the 0.0
operating line-to-line voltage as stated on the
machines rating plate. Testing up to the line-to-
line voltage not only covers the insulation to
ground but also the performance of the interphase insulation, and is strongly recommended for acceptance
testing of new stator windings. Other common Uwax levels are up to the operating line-to-ground voltage
(Uwax/V3) or up to 120 % of the operating line-to-ground voltage (1.2 Uuax/V3). The maximum test voltage is
often agreed between the owner and service group and is chosen according to the kind of test, e.g., a peri-
odical test or a test after repair.

0.0 80 U K] 16.0

Figure 73: Test sequence of a 15 kV winding, PD and TD vs. voltage

After the inception voltage is found, phase resolved patterns can be mapped and compared with typical
phase resolved pattern from known PD origins (see section 6.2.5). The recommended value for the PD pat-
tern test time is between 30 s and 60 s when working at power frequency (50 Hz—60 Hz) and about 1000 s to
1500 s when using very low frequency (VLF) power supplies.

As well as the pattern, the related discharge levels (Qp, Qec) and the average discharge current (NQS) are
given. Relevant data for test reports relating to rotating machines are: Summary table of all test results versus
voltage, partial discharge inception and extinction voltage, and the phase-resolved patterns at each voltage
step. The ICMflex software supports export of this data as a file for MS Excel.
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6.2.4 Step-by-step guide

To simplify measurements, a step-by-step guide has been implemented in the ICMflex standard software.
This guides users through the required steps prior to and during the measurement. The step-by-step guide

option is enabled via “Edit”->"Edit Preferences” in the “Mis-
cellaneous” tab. The settings related to the step-by-step

measurement are found on the “Step by Step Guide” tab,
shown in Figure 74.

1.

Step 1: Figure 75 shows the screen for step 1. The user has |
to enter the general information such as:

Voltage Cycles to Stabilize: The system recognises the

; -
applied voltage after having detected the selected number : shew ST

.
of stable cycles between the fixed voltage tolerance levels.

Cycles per Measurement Interval: This setting determines
the number of averages taken for the tan delta measure-
ment at a certain voltage level after detection of a stable
voltage level between the fixed voltage tolerances

Voltage Tolerance: Selectable in volts [V] or percentage
[%]. Tolerance on the accepted difference between the

applied voltage during test procedure. Figure 74: Preferences window

Time To Stabilize Voltage: Waiting time until measured values are recorded at the set test voltage, to en-
sure stable voltage values when pattern recording starts.

Work number
Machine type
Serial number
Nominal voltage
Phase to be tested
Maximum voltage
Measured by
Approved by

Figure 75: Measurement Setup Guide screen
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After filling in individual fields, the background colour of the
text box changes from red to black when the entry is con-
firmed by pressing the enter button. The nominal voltage to
be entered is the operating phase-to-phase voltage of the
stator winding. The user can choose to record data for each
phase separately or all three phases together (star point con-
nected). The maximum voltage for the record file is adjusta-
ble, varying from 0.8 x Uy to 1.4 x Uy in steps of 0.2 Un. Once .
all the required fields are filled in, the upper guide bar will in-

dicate “Confirm to Continue“. The settings are saved by
pressing the “Confirm*“ button below in the guidance screen. | 2

Pressing the “Cancel” button stops the step-by-step proce-
dure.

If the user confirms the entered data, the upper guidance bar
will indicate “Completed” in a green font, and the software Figure 76: Completed first step
continues to the next step (Figure 76). If an error is detected,

the step can be fully deleted by pushing the “Clear step” button.

Step 2: Selection of synchronisation frequency (Figure 77)

In step 2 the user selects the synchronisation frequency for the measurement from the “Sync Mode“drop-
down list. Available options are:

Normal: 50-60 Hz, power frequency
® VLFO0.1Hz

® VLF 0.05Hz
® VLF0.02 Hz

Depending on the synchronisation frequency, the appropri-
ate set time must be chosen. Power Diagnostix has prede-
fined recommended set times for each frequency. The user
can choose between selecting the recommended set time or
entering a custom set time based on their own test proce-
dure. The predefined set times are:

® Normal: 60 seconds

® VLF 0.1 Hz: 1500 seconds

® VLF 0.05Hz : 1500 seconds Teet Enginests Hame

Supenisor name

® \/LF 0.02 Hz: 3000 seconds

Figure 77: Synchronisation frequency selection
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After entering and confirming the set time, the user prompted to enter a file name (Figure 78). This can be
done by pushing the button “Filename* at the bottom of the guidance menu. All measured data at each volt-
age interval will be stored under the entered file name into in the relevant folder on the computer’s hard drive.

Fir o o 1205
feamyen  [rm

i

Figure 78: File name selection

After the file name and desired location on the computer’s hard drive have been selected, the second guid-
ance bar in the upper guidance screen will show “Completed” in a green font and will ask the operator to
continue with step 3. If an error is detected, the step can be deleted by pushing the “Clear step” button and
the data entry can be repeated.

Step 3: Partial Discharge Calibration (IEC 60270)

The third step of the measurement guidance asks the user to perform calibration of the apparent charge for
the partial discharge measurement. Therefore, they must connect the calibrator to the winding that is going
to be measured. The calibrator must be connected, as shown in Figure 71.

It is important to consider the signal-to-noise ratio (SNR). The user should inject a calibration pulse of suffi-
ciently large amplitude, so that it is possible to clearly distinguish it from the level of background noise present
(see Figure 79). Common charge levels injected for rotating machines are 500 pC, 1 nC, 2 nC, and 5 nC. In
general, the charge to be injected will be determined by the complex impedance of the stator winding and
by the measurement set-up. Performing the calibration, provides a reference to compensate for changes to
the injected signal (especially attenuation), such that the pulse amplitude reaching the ICMflex via the phase
terminal under test can be scaled to a known amplitude level. By double clicking on the upper calibrator line,
the injected value can be entered in a dialogue box (Figure 79) which will appear on the screen.
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7.16

358

Signal to noise ratio

0o

0 180 [deg)

Figure 79: PD calibration

The steps that have to be performed to complete the calibration sequence are shown in Figure 80. They are:
® Connect the calibrator

® Start pattern: wait for 10 s (standard acquisition time for calibration)

® Double click on the calibrator pulse

Figure 80: Calibration sequence

After the injected calibration pulse is entered, the calibration file will be stored into the .flx file with the chosen
file name in the selected location on the computer. The third guidance bar in the upper guidance screen will
now indicate “Calibration done” in a green font and ask the user to continue with the next step by pressing
the “Next >" button in the lower right corner of the guidance screen.
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Step 4: Apply voltage

The next step in the measurement process is to apply voltage. In the upper guidance bar, the required voltage
level will be indicated (see Figure 81). It is shown as a phase-to-ground or phase-to-phase voltage.

From this point in the sequence, the user can go back to the previous step by pushing the “< Back® button
or go to the next step by pushing the “> Next" button. Note that “> Next“ only becomes available when a
step has been completed.

The instrument will recognise the voltage level automatically.

Until the desired voltage within the fixed tolerance is reached, the second guidance bar will indicate “Waiting"“.
Once the required voltage level is reached, the first guidance bar will change into “Voltage reached” in a
green font, and the second guidance bar will show now “Acquire Tan Delta Values" as shown in Figure 82.

Acquire Tan Delta Values
Press "Next to continue. Press "Next to continue.

pe

Drive to 1.3 KV (Fh-G) /2.2 k¥ (Ph-Ph) Voltage Voltage reached

Remaining

| 2937k 300 s

Figure 81: Guidance screen while waiting for the voltage Figure 82: Guidance screen after reaching the test volt-
level to be reached age

The tan delta measurement will now be performed automatically according to the settings in the preferences.
When the number of averages is reached and values are stored for a particular voltage step, the second
guidance bar will show “Start Pattern Acquisition” for performing the partial discharge measurement (Fig-
ure 83). The voltage level and remaining acquisition time will always be shown on the left-hand side in the
lower part of the guidance window.
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Voltage reached Voltage reached
Start Pattern Acquisition Pattern Acquisition finished
Press Mext to continue. Press ‘Next' to continue.

— Work o

Phase(s) yminal\ P )

Remaining

'

Figure 83: Guidance screen for starting the PD pattern Figure 84: Guidance screen after completing pattern ac-

quisition
Pattern acquisition is started by pressing the “Start Pattern® button at the bottom of the guidance screen (see
Figure 83). The pattern will be collected over the set time. Once the pattern is acquired, the second guidance
bar will indicate “Pattern Acquisition finished” in a green font. The user has to confirm this message by press-
ing the “Next >" button. The pattern will then be stored under the selected file name, per voltage step, in a
fix file. If necessary, the pattern can be mapped again should some of the settings need to be adjusted. The
previously stored pattern will then be over-written by the new pattern. To map a new pattern, use the “< Back"
button.

After having confirmed a successful pattern acquisition by

pressing “Next >", the guide will show the next voltage
step. When ramping-up the voltage, the user must cross

check the gain settings for Un and Ux to ensure that the
capacitive voltage dividers are not over-ranged. Should -

this happen, a warning will be generated in the second
guidance bar “U_sn (or _sx) Overrange - Decrease U sn
(or sx) Gain” (Figure 85). The corrective action required
will also be indicated. The maximum voltage for
Usn is 14V RMS, and for Ug, itis 140 V RMS. The actual
voltage drop on the capacitive dividers can be observed in
the upper left chart by selecting Uaqq, located in the upper
right-hand corner of the chart. After adjusting the gain set-
tings properly and detecting that the applied voltage is
within the fixed tolerance, the message “Voltage Reached”
will appear in a green font in the first guidance bar. The tan
delta records will be made, and afterwards, the pattern can
be acquired again. This procedure must be repeated until the last voltage step is reached.

name of test Engineer
name of testing Supervisor

Figure 85: Voltage over-ranging
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As well as the gain settings for both voltage dividers, the gain for the partial discharge measurement must
also be monitored. At each voltage step, check if the PD activity present is within the maximum scale of the
pattern. If not, increase or decrease the PD gain accordingly.

When pattern acquisition for the last voltage step is fin-
ished, the entire table will have been filled automatically by

Measurement finalized

the software. The upper guidance bar will show the mes-

sage “Measurement finalized", and the second guidance |
bar will prompt the operator “Print measurement or start —_——————————————

new measurement” (see Figure 86). The test report can be
printed by pressing the “Print” button located in the lower
right-hand corner of the guidance screen. The report will
be printed and shown on the computer screen.

11.0kV Fhase(s))

name of test Engineer
name of testing Supervisor

SyncMode

Mormal

Figure 86: Printing/new test guidance screen

After having printed the report or started a new test, the button “Keep Infos* appears in the lower area of the
guidance screen. This option is implemented to keep the machine details, etc., for consecutive measure-
ments on the same machine. For instance, phase V after finishing phase U. In this case, it is only necessary
to re-select the phase name, the file name and to do the PD calibration for the relevant phase. When perform-
ing consecutive measurements for the next phase or all three phases together, for instance, the principle of
measuring stays the same — that is, the operator will be guided through the complete sequence again, step
by step. If the “Clear all* button is pressed, all of the machine information will be deleted.

Measurement finalized
Print Measurement or Start New Measurement

Fhase(s}

name of test Engineer
name of testing Supernvisor

Figure 87: Final guidance screen
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6.2.5 Typical PD patterns and tan delta levels on rotating machines

To simplify the evaluation of measurement results, you can find here some common partial discharge pat-
terns versus PD origin and tan delta evaluation criteria, based on rotating machines standards and other relat-
ed literature. Power Diagnostix has more than 25 years’ experience in PD diagnostics on rotating machines.
The following table gives an overview regarding regular PD levels and miscellaneous PD phenomena.

In general, partial discharge activity is inherent to epoxy-mica insulation systems. Compared with other insu-
lation systems where the PD level criteria are specified in the lower pC ranges, such as XLPE for medium and
high voltage cables or oil-paper insulation systems for power transformers, the common PD levels for stator
winding insulation systems are higher. Epoxy-mica insulation systems also widely tolerate partial discharge
activity since these systems are developed to be partial discharge resistant for many years. Performing PD
tests on new machines provides a baseline for further trending over time, and, if design faults are present, it
will reveal them. Basically, every significant deviation from regular internal PD can be considered as a poten-
tial problem with insulation quality, and the root cause must be investigated.

As the measured apparent charge levels depend on many different parameters such as measurement set-
up, measurement frequency, location of the coupler, test voltage, insulation system, and PD location within
the winding, there are currently no specified no-go criteria. The levels given below are indicative values.

Spherical void discharge >500 pC

with low availability of starting
electrons

] 180 | den] 360

Surface discharge 0-2nC >2nC w523

[nC]

at the slot exit

the first stage of field grading
problem
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Thermally aged main insula- | <5 nC >5nC
tion
[ei2]
symmetrical in both half-cy- |8
cles
Slot discharges with machine | 0 nC >5nC . o
bars I 0,
[ ] ; il e
non-symmetrical
predominantly in the negative
half-cycle _ i
] L131 L] e
Surface discharges at the 0-2nC >20nC
end winding

Table 7: Typical rotating machine patterns

Stator winding | 0.2 Uy < 30x 10073 > 30 x 1003 Relevant standard: IEC 60894
Un < 60x 1007 > 80x 100°
, . . Often, different tan delta levels are
g'g'lljp per < 5x100 > 5x100 found between various insulation
. N A
at 50 Hz at 50 Hz tr?/caes such as global VPI and resin
Single bar 0.2 Un < 30x100° Relevant standard: IEEE 286-2000
Un < 60x 1003 Please be aware that it is only reason-
Tip-up per 5_7 1002 able to test fully cured coils.
0.2 Uy 10 % of the complete set needs to be
at 50 Hz examined.

Table 8: Common TD evaluation criteria for rotating machines
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6.2.6 Normative references

TS IEC 600034-27: Off-line partial discharge measurements on the stator winding insulation of rotating
electrical machines

IEC 600034-27-3:  Dielectric dissipation factor measurement on stator winding insulation of rotating elec-
trical machines

IEC 60894: Guide for test procedure for the measurement of loss tangent of coils and bars for ma-
chine windings

IEEE 286-2000: Practice for Measurement of Power Factor Tip-Up of Electric Machinery Stator Coil In-
sulation

6.3 Stator bars
6.3.1 General

The principle for PD and tan delta testing on separate stator bars using the ICMflex is very similar to testing
complete assembled stator windings. In this case, the coils are not assembled into the magnetic stator core,
so0, an artificial core should be provided to ground the straight part of the coils. Common materials used for
applying grounding electrodes (as simulated slots) are conductive adhesive tapes or copper/aluminium bars.
It is important that the ground electrode has a similar length as the real stator core. It is even more important
to achieve optimal contact between the ground electrode material and the slot’s semi-conductive outer layer.
When copper/aluminium bars are used, pincers can be used to ensure good contact, as shown in Figure 88.
Coils can be tested completely by bridging the grounded straight parts of both coil ends or tested partially
by grounding the straight part of one coil end only. The main purpose of tan delta and tan delta tip-up testing
is to determine the general condition of the coil’s ground wall insulation (see section 10.1). The test results
mainly show the performance of the slot’s conductive outer layer, acting as the ground electrode to the mag-
netic core.

Generally, stator bars with rated voltage of 6 kV or more are provided with a field grading junction, consisting
of a semi-conductive material, e.g., silicon carbide, at the slot-exit area. The function of the grading junction
is to controll the surface field at the coil’s slot exit in proportion to the distance from the core. Depending on
the rated voltage, this high resistance material with non-linear resistive characteristic has a specific length and
overlaps with the slot’s linear resistive outer layer. Usually, the overlap between these two layers is outside
the magnetic core.

These semi-conductive materials can influence the overall tan delta level, as they show a resistive loss under
influence of high voltage potential. Therefore, standards such as the IEEE 286-2000 and the IEC 60034-27-
3 require the use of guard rings during the tan delta test to eliminate the influence of these resistive losses.
When using guard rings, the aim of the tan delta measurement, i.e., checking the performance of the slot co-
rona prevention layer, is achieved without the results being influenced by the semi-conductive materials used
for the field grading. For this reason, Power Diagnostix designed the ICMflex GRC, with guard ring control.
For complete windings the contribution of the resistive losses produced by the semi-conductive material in
the overall tan delta level can be ignored, and hence, the standard ICMflex can still be used.
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6.3.2 Test set-up

The PD and tan delta measurement set-up using the standard ICMflex is very similar to the testing of com-
plete windings (see section 6.2.1). Instead of connecting the grounding to the motor or generator frame, it is
connected to the simulated slot on the straight part of the stator bar. If the entire coil needs to be tested, both
straight parts are interconnected. The high voltage output of the ICMflex must be connected to the coil’'s HV
conductor circuit.

Coil's HV conductor Interconnection

Simulated slot

Figure 88: PD and TD testing of resin rich bar Figure 89: Testing of resin rlch bar for an asynchronous motor
for a small hydro generator

6.3.3 PD calibration

In general, the calibration procedure for the PD measurement is similar that is described in section 6.2.2.
Since the test circuit for a single bar has a fairly low capacitance, a lower calibration charge can be selected
than for fully assembled stator windings. Common charge levels are in the range of 100 pC to 500 pC. The
PD calibrator should be connected between the HV conductor circuit of the coil and the simulated slot (GND
clamp).

6.3.4 PD and tan delta measurement

The measurement procedure is similar as described in section 6.2.3 for testing complete windings. Depend-
ing on the applicable standard (see section 6.3.6), the procedure and levels of applied voltage might be
different. In the examples below, tan delta measurement results are shown for a 10 kV resin-rich bar without
guard rings (Figure 90) and with guard rings applied (Figure 91). As well as the results in strip charts, the
slope of the tan delta graph versus voltage clearly shows the effect of the resistive losses of the semi-conduc-
tive layer.

10.0
40.00
CXInF]
E3)
20,00 -
L utv | tano | peanb) | cximl | apieci |
i T 1 202 1.256-02 MIA 1.116 10.8
2| 403 13902 138E03 1119 200
3| 601 1s4E02 140803 1121 581
o0 . 4|  e28 176E02 220603 1124 667
00 50 U100 5| 990 191E-02 148E-03 1126 720

Figure 90: Tan delta measurement without guard rings
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207 986E-03  NA 1085 000

2 208 984E-03 -233E-05 1085 000
3 405 100E-02 196E-04 1086 387
608 102E-02 180E-04 1085 403
798 104E-02 136604 1085 516
090 105E-02 154E-04 1085 731

Figure 91: Tan delta measurement with guard rings

6.3.5 Typical patterns and tan delta levels on single stator bars

The partial discharge patterns are very similar to those given for rotating machines in section 6.2.5. However,
for the tan delta measurement, different criteria are applicable. Common levels are specified in Table 9 below.
In contrast to the testing of complete windings, both IEC and IEEE have specified evaluation criteria for the
tan delta measurements on single stator bars.

According to IEC 60034-27-3 these criteria are valid for resin rich insulation systems as well as for vacuum
pressure impregnated (VPI) systems.

For the partial discharge measurement, no criteria are given. Based on past measurement experience, reg-
ular levels for internal PD in well made new bars range from <100 pC up to 500 pC. When testing a batch of
coils, it is specified that 10 % of the complete set must be tested. The intention is to compare the results and
check conformity. This procedure allows defining average levels per coil type, and, hence, any deviations in
the sample testing can point to problems with a particular bar.

Single bar 0.2 Un <20x10°%/ Relevant standards: IEC 60034-27-3
<30x10° and |IEEE 286-2000
Un <60x10° Please be aware that is only reasona-
Tip-up per 5x 102/ ble to test fully cured coils.
0.2 Un 2-7x10° 10 % of the complete set needs to be
examined.
at 50 Hz

Table 9: Common TD evaluation criteria for stator bars

6.3.6 Normative References

[EEE 286-2000: |IEEE Recommended Practice for Measurement of Power Factor Tip-Up of Electric Ma-
chinery Stator Coil Insulation

IEC 600034-27-3: Dielectric dissipation factor measurement on stator winding insulation of rotating electrical
machines

IEC 60894: Guide for test procedure for the measurement of loss tangent of coils and bars for ma-
chine windings
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7 Options
7.1 Guard Ring Control (GRC)

In order to meet the requirements of the IEEE 286-2000 and IEC 60034-
27-3 standards for dielectric dissipation factor testing (also known as
tan delta testing) on rotating machine stator bars, Power Diagnostix
upgraded the design of the existing ICMflex to produce the ICMflex
GRC (Guard Ring Control). Both standards require that tan delta test-
ing on stator bars is performed using guard rings to negate the resis-
tive losses of the semi-conductive layer.

The guard ring control option provides two driven guard inputs on the
ICMflex acquisition unit. An internal voltage follower circuit keeps the
surface potential of the semi-conductive layer equal to the surface po-
tential of the simulated slot. This means that leakage currents created
in the semi-conductive layer flowing from this layer to the straight part
of the stator bar are intercepted, and therefore do not influence the
dissipation-factor measurement.

The ICMflex GRC is optimised for the capacitances of stator bars
ranging from small asynchronous induction motors up to the Roebel
bars in large synchronous turbogenerators. The embedded voltage
divider for up to 30 kV RMS comes with a DAKKS calibration certificate.

The general principle of operation is similar to that of the regular Figure 92: ICMflex GRC

ICMflex. It still supports simultaneous PD and tan delta measurement,

and hence, the operational software for the ICMflex GRC is the same as that for the ICMflex. The main differ-
ence with the standard unit is that the acquisition unit is at low voltage potential allowing the incorporation
of guard rings. Additionally, the battery is now internal. The instrument can operate either from the battery or

from the line supply.

7.2 Additional PD input for noise cancellation (ICMflex2)

The ICMflex2 makes it possible to separate pulses from the test ob-
ject and pulses from the test voltage source by their polarity. The in-
strument offers a second PD input, as shown in Figure 93, for PD
pulses separated from a quadrupole that is built into the HV filter.
Another quadrupole is in the path of the coupling capacitor, in the
same position as in the standard ICMflex. With this configuration,
pulses from the test object and pulses from the test voltage source
have opposite polarities (see Figure 95). The acquisition unit looks at
the polarity of each pulse and sorts it into either a PD pattern or into a
disturbance pattern.

Figure 93: Additional input for noise cancel-
lation ‘PD2 IN’

pdix.com
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With an additional PD input there are some additional op-
tions selectable in the preferences panel of the ICMflex

software. These are shown in Figure 94. The user can de-
termine if different filter configurations should be used for
the main and the auxiliary channel (not recommended)
and whether or not these two channels should use the
same configuration. “DSO & Scope View” determines the -
behaviour of the software when changing the channel dur- r
ing acquisition, while “Pattern Acquisition” shows, which

channel is used for the acquisition of a PD pattern. It is
also possible to change the gating time or use the default
value of 10 us. The “Circuit attenuation” setting determines
the attenuation difference between the acquisition channel
and the disturbance channel so that the gains of the two
channels can be matched.

The “DSO Bandwidth” can be switched to “IEC 60270 for
optimised time resolution during fault location. The DSO
normally operates with an extended bandwidth of 20 MHz.

Figure 94: Multi-channel options

To determine the polarity, each pulse must be acquired separately. Acquisition is triggered when one of both
channels exceeds the low level discriminator (LLD) setting. At this instant, the dead time starts, and at its end,
the positive and negative peak amplitudes of both channels are digitised. To achieve t a good pulse separa-
tion, both values must be set very carefully. It would be ideal to set the LLD higher than the noise floor, but in
order to see the noise floor in the acquisition pattern, it is recommended to set the LLD to a value which allows
triggering only on the highest noise pulses. If the LLD is set too low, the acquisition is triggered too often on
noise pulses rather than PD pulses. The dead time must be set to the length of the pulse oscillation. If it is set
too short, the pulse will not be finished and double triggering can result. If it is set too long, a second pulse
may arrive within the dead time, and the smaller pulse will be ignored.

Depending on the ICMflex2 configuration, the two quadrupoles may have different sensitivities. In this case,
the PD gain must be set separately for the two channels. To compare the sensitivities, the user can switch
to the auxiliary channel during calibration and set the gain so that the calibrator pulse amplitude is similar to
that of the main channel. The LLD can also be set individually for each channel. To get equal pulse properties
on both channels, their high-pass and low-pass settings should be equal. To achieve this, the separate filter
configuration can be disabled in the multi-channel options of the preferences (see Figure 94).

The ICMflex2 functions can be used with the two right-hand screens in the PD and LOC display of the ICMflex
software. Three additional settings are available with these displays:

Channel: For toggling between the main and auxiliary channel in the screen on the upper right-hand side.
Rejection:  Offers three different modes of noise cancellation (“First Pol.“, “Peak Pol.“, and “F&P Pol.“)

Dead Time: Time during which a signal is converted, and which is reserved for a single pulse. The A/D con-
verter will not convert or accept another signal during this time, so additional pulses occurring
within the dead time are lost.

In general, there are two different methods of pulse polarity detection. The first is to decide at what polarity
the LLD is exceeded first (“First Pol.”). The second is to compare the peak amplitude of both polarities at the
end of the dead time (“Peak Pol.”). Additionally, the ICMflex2 offers an AND combination of both methods
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(“F&P Pol.”). The effectiveness of these methods depends on the repetition rate and the amplitude ratio of
the two pulse sources. If there is a high repetition rate, the “First Pol." method has a problem when a large
disturbance pulse follows a smaller PD pulse. If the amplitude of the pulse sources is very different, the “Peak
Pol." method has a problem; if one pulse is over-ranged in both polarities, the peak amplitudes cannot be
compared. Examples of pulse polarity detection are shown in Figure 97 to Figure 100.

Calibration and PD measurement is usually done with the main channel. If “Switch to Active Setup” is selected
for “DSO & Scope View” within the preferences (see Figure 94), the corresponding screens of the PD and
LOC display can also show the auxiliary channel, but no calibration is possible, as the amplitude is shown in
percent. For the upper right-hand screen, it is possible to choose, whether the scope view displays the acqui-
sition pattern or the disturbance pattern. The lower right-hand screen always shows the acquisition pattern.

To view the shape of the pulses used for the pattern choose “IEC 60270“ for “DSO Bandwidth® in the mul-
ti-channel options of the preferences (see Figure 94). In IEC 60270 mode, the DSO shows the filtered signal
used for the pattern and the polarity decision. In this mode, only the PD gain is relevant.
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Figure 95: General connection diagram for ICMflex2
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Figure 96: ICMflex2 and line filter LF450 installed on an external coupling capacitor
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o Polarity of first pulse exceeding the LLD Sampled peak values
o Polarity of maximum pulse amplitude Peak hold
Pulse from test object Pulse from test voltage source
f Deadtime ! L Deadtime ,E
° = °
LD =@ -\ -y mm oo : LLD --@----}--- /\\ """""""" ﬂl
CH1 \/A ; CH1 \/A ,
o |
LLD -- b\ 1: LLD --a----7-1-- AT :
CH2 — \jﬂv : CH2 — \}/ t
. i o
Figure 97: O and O have positive polarity on both Figure 98: O positive polarity on channel 1,
channels negative polarity on channel 2;
=> ‘First Pol.” and ‘Peak Pol.” have the O positive polarity on channel 1,
same result. negative polarity on channel 2

=> ‘First Pol.” and ‘Peak Pol.” have the
same result.

Pulse from test object followed by larger pulse Pulse from test object with too high amplitude

from test voltage source within deadtime (clipping on both polarities)
L Deadtime ;i L Deadtime =i
i o ' '
LLD“A“" R e ""i
CH1 — \//\V v/\\/“ !

[ o s ey o s o a
CH2 —+- \/ \V/ VI\V d
: o ' o
Figure 99: O Positive polarity on both channels; Figure 100: O Positive polarity on both channels;
O positive polarity on channel 1, negative O no decision possible,
polarity on channel 2 => only ‘First Pol.’ result is correct: Pulse
=> Only ‘Peak Pol.’ result is correct: gets sorted into disturbance pattern.

Pulse gets sorted into disturbance pattern.
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7.3 Gating via fibre optic link (FO gating)

An ICMflex with an FO gating function has an additional terminal (“FO GATE IN” for a fibre optic (FO) cable,
which sends the signal from the gating signal transmitter (GST1) to HV potential. The transmitter is included
in the scope of delivery if FO gating is ordered. An external signal sensor (e.g., CT1) is connected via a BNC
cable to the “GATE IN” terminal of the GST1.

Analogue
GATE IN
only!

Fibre optic
GATE IN

Figure 109: Gating inputs

If disturbances like relay switching or thyristor firing have a known source, it might be possible to create a TTL
signal relating to the disturbance. This signal can be used to gate the PD measurement path. If a TTL signal
is available, it can be connected via a BNC cable to the “TTL IN” terminal of the GST1.

Caution: Never connect the GST1's BNC TTL output to the analogue gating input of the ICMflex. This will
result in serious damage of the instruments!

FO gating and analogue gating can be used simultaneously.
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Figure 101: Gating connection diagram
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The gating signal transmitter GST1 is shown in Figure 102. It offers logarithmic amplification and can be set
to three different frequency ranges (40-800 kHz, 2-20 MHz, or 200-600 MHz), which can be selected with
a push-button. The active bandwidth mode is shown by a green LED. The gate level can be adjusted with the
GST1 rotary switch and is indicated by the orange LED. The level of the analogue signal incoming via “GATE
IN” is indicated by the green LED bar. If it exceeds the selected gate level, the bar changes to red. The gate
level should be set to the maximum when using a TTL gating signal as the only signal source.

Output for gating signal to ICMflex
(FO TTL GATE OUT)

Input for analogue gating signal \ ;

Input for TTL gating sighal ——— I3

\/

LED scale indicating the level of the
incoming analogue gating signal
and the selected gate level

Button for bandwidth selection and
for switching on/off

Output for TTL gating signal —— 15
(e.g., to ICMsystem or ICMcompact)

Rotary switch for gate level adjustment

9V power supply

Figure 102: Gating signal transmitter (GST1)

1 ) TTL Gate Out
Analog Gate In — 1] ~|ft-cate lewp »| Peak > . » (FO cable)
(RG58 cable) 1 detection |Peak > Gate level 3
» OR
Legateln ——— — : TTL Gate Out
( cable) . ; (RG58 cable)

Figure 103: Disjunction of gating signals when simultaneously using analogue and TTL gatlng
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7.4 Bypass

If the capacitance of the test object is too high, the ICMflex for tan delta measurements can be fitted with a Cy
bypass to avoid overstressing of the shunt capacitor. With the bypass active, loss factor measurements are
disabled but PD diagnostics are still possible.

Figure 104: Jumper in bypass mode

7.5 Built-in RPA1L

For applications requiring high sensitivity, the ICMflex can be fitted with a built-in preamplifier
(RPA1L), which reduces the instruments input sensitivity to 15 uV. It has switchable pre-gain 0
of 1, 10, and 100. The ICMflex with preamplifier has an extended gain list (4 to 80000, see Fig- 2
ure 105). From 4 to 100 the pre-gain is 1, from 200 to 1000 the pre-gain is 10, and from 2000 40
to 80000 the pre-gain is 100. The range of DSO gain is also influenced by the pre-gain, and the 30

total DSO gain cannot be lower than the pre-gain. v 100
200

If there is an incorrect connection or a short circuit in the cable from the ICMflex to the RPATL, the 44,

software shows a warning by changing the background colour of the “PD Gain” setting to red. 200

If an ICMflex2 is equipped with a built-in preamplifier, a second RPA1L must to be installed as m

close as possible to the quadrupole in the HV filter. 4000
8000
10000
20000
40000

Figure 105: Extended gain list 80000

7.6 External battery adapter

Power Diagnostix offers an external battery adapter for connecting larger batteries to the instrument, instead
of using the standard ICMflex battery BAT2A.
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8 Miscellaneous

8.1 Maintenance

The ICMflex does not require any maintenance on a regular basis, neither is regular fine adjustment need-
ed, as partial discharge measurement is a relative measurement that is calibrated with a reference source
(charge calibrator, CAL series) prior to a measurement. The instrument receives high frequency PD signals
and assigns them with a pC level based on the calibration made prior to testing. In case of daily usage, it is
recommended to calibrate the impulse generator annually to ensure that its output signal remains within the
recommended limits. The only part of the instrument that requires calibration is voltage measurement. Volt-
age calibration should also be calibrated annually, unless the customer’s calibration policy defines a different
time interval.

Please take care that the instrument stays clean. Any conductive contamination might result into leakage
current, which can influence the tan delta measurement results.

8.2 Product marks

This symbol indicates that the marked product should not be disposed of as normal house-
hold waste. As it is a B2B product, it may also not be disposed of at civic disposal centres.
If you wish to dispose of this product, please do so properly by taking it to an organisation
specialising in the disposal of old electrical equipment near you.

Any batteries installed must be disposed of separately from the unit.

As a responsible manufacturer, certified according to ISO 14001, Power Diagnostix offers to take back old
instruments from its customers. Please contact Power Diagnostix at support@pdix.com to discuss the pro-
cedure for this.

8.3 Transport and shipment instructions
8.3.1 Instrument

Generally, we recommend transporting the high voltage filter and the ICMflex in a vertical position to prevent
problems with the HV and GND connections of the ICMflex reference capacitor and the T-filter damping ca-
pacitor.

If a unit needs to be returned to the factory, make sure the acquisition unit is packed safely. Please use the
boxes provided for the shipment. As the units are relatively large, shipment by a forwarding agent is the rec-
ommended mode of transportation. If possible, declare the instrument as ‘used instruments for evaluation’ at
a relatively low value. Consult Power Diagnostix for further details. Power Diagnostix may provide you with a
temporary replacement unit in urgent cases.

8.3.2 Batteries

If an instrument is suspected to contain a faulty battery module, the module must be removed before the
instrument is shipped. Never ship a faulty battery module, either separately or connected to an instrument.

pdix.com User guide for ICMflex

79


mailto:support%40pdix.com?subject=

80

ICMflex
Partial discharge and loss factor measurement system

8.4 Declaration of Conformity

The manufacturer

Power Diagnostix Instruments GmbH
Vaalser Strasse 250

52074 Aachen

Germany

declares that the product

ICMflex

Partial discharge detector for use in high voltage areas

provided it is installed, maintained, and used for which it was made, in accordance with relevant installation
standards and manufacturer’s instruction, meets the requirements of the following directive(s):

Low Voltage Directive 2014/35/EU
EMC Directive 2004/108/EG
RoHS Directive 2011/65/EU

It complies with the following standards and/or normative documents:

EN 61010-1:2020
EN 61326-1:2013
EN IEC 63000:2018

Aachen, 13/03/2024
Dr. Mihai Huzmezan
(CEO, Power Diagnostix Instruments GmbH)

Note: Since the measurement of partial discharge pulses is done in frequency bands partly occupied by
radio transmission, and since test leads may act as antennas, disturbance-free measurements may require
well-shielded environments and/or additional filter techniques.
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8.5 UK Declaration of Conformity

The manufacturer
Power Diagnostix Instruments GmbH

Vaalser Strasse 250

52074 Aachen
Germany
declares that the product

ICMflex

Partial discharge detector for use in high voltage areas

provided it is installed, maintained, and used for which it was made, in accordance with relevant installation
standards and manufacturer’s instruction, meets the requirements of the following Statutory Instruments:

S12016 no. 1101 The Electrical Equipment (Safety) Regulations 2016

S1 2016 no. 1091 The Electromagnetic Compatibility Regulations 2016

S12012 no. 3032 The Restriction of the Use of Certain Hazardous Substances in Electrical and Elec-
tronic Equipment Regulations 2012

It complies with the following standards and/or normative documents:

EN 61010-1:2020
EN 61326-1:2013
EN IEC 63000:2018

Aachen, 13/03/2024
Dr. Mihai Huzmezan
(CEQ, Power Diagnostix Instruments GmbH)

Note: Since the measurement of partial discharge pulses is done in frequency bands partly occupied by
radio transmission, and since test leads may act as antennas, disturbance-free measurements may require
well-shielded environments and/or additional filter techniques.
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9 Technical data (standard version)

Mains supply:

Power requirements:
Operation:

PD input impedance:

PD input sensitivity:
(without test object)

PD lower cut-off (-6 dB):

PD upper cut-off (-6 dB):

PD A/D converter:

Voltage measurement:

Voltage values displayed:

Synchronisation:

Synchronisation range:

Operation temperature:

Interfaces:

Battery operated (up to 6 hours)

Approx. 20 VA

Remote controlled via ICMflex software

1kQ // 50 pF

< 150 uV, corresponds to 0.2 pC
< 15 uV, corresponds to 0.02 pC

40, 80, or 100 kHz
250, 600, or 800 kHz
8 bits (=7 bits)

16 bits, 100 kSamples

(without built-in preampilifier)

(with built-in preamplifier; ICMflex2 only)
(

(

software-controlled)

software-controlled)

U RMS value, U/V2 value, crest factor

External on reference voltage

20-510 Hz
0.1 Hz, 0.05 Hz, 0.02 Hz

0-55°C

Bluetooth
Fibre optic serial link

9.1 Cable fault location

A/D converter:
Samples:

Specimen cable length:

Localisation precision:

8 bits
100 MSamples

normal mode)
VLF)

(
(
(non-condensing)
(
(

921 kBit/s)
921 kBit/s)

10 to 5000 m, for a sample rate of 320 us and ve = 160 m/us
(Localisation on cables longer than 5000 m is not possible because of pulse attenuation)

1 m + 0.1 % of the cable length

9.2 Loss factor measurement

Tan delta resolution:

Tan delta precision:

5x10°
1x10%

User guide for ICMflex
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9.3 Weight and Dimensions

ICMflex

Partial discharge and loss factor measurement system

Measurement

system

ICMflex 30 kV 22 600 350 350

ICMflex 50 kV 23 800 350 350

ICMflex 100 kV 24 800 350 350

ICMflex 150 kV 60 1600 450 450

ICMflex >200 kV - - - To be installed on separate HV
reference capacitor of min. 1 nF.

ICMflex2 >200 kV 220 365 350 To be installed on separate HV
reference capacitor of min. 1 nF.

Filter unit

T30 30 kV 35 610 350 350

T50 50 kV 40 800 350 350

T100 100 kV 46/58 985 350 350

T150 150 kV 65 1200 350 350

LF450 - 130 512 450 450 To be installed on separate

HV blocking capacitors of min.
10 nF.

pdix.com
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10 Appendix
10.1 What is loss factor (or dissipation factor) tan delta?

Building high voltage equipment requires the use of insulating material. Commonly used insulating materials
show losses due to resistive currents and polarisation currents of dipoles. Often, the magnitude of these
losses can be used as an indicator for the quality of the insulation. In particular, when assessing the quality
of aged insulation, increased dissipation indicates oil or paper decomposition (transformers), humidity, elec-
tro-chemical processes (water-trees in polymeric cables), or heavy partial discharge.

With an ideal capacitor (C), the resistance of the insulating material (dielectric) is infinite. When an AC voltage
(V) is applied, the current (Ic) leads the voltage by exactly phi =

90 °. A component close to this ideal capacitor with negligible re- Ic

sistance should be used as standard (or reference) capacitor for l

the reference branch of a dielectric loss analyser. o

Practical insulation systems are usually built of less than perfect
insulating material, resulting in a small current (lg) in phase with
the applied voltage (V). This current can be considered as flowing
in a resistor (R) in parallel with an ideal capacitor (C). The phase
difference between the actual current (1) and the ideal current (Ic)
can be described as phase angle: delta.

Because P = Q - tan delta, where P is resistive power and Q is
reactive power, the losses, which are proportional to tan delta, will
usually be given as a value of tan delta to express the quality of
an insulating material. The angle delta is described as loss angle
and tan delta as loss factor.

L f r

phi ~90°), the actual current (lc) is approximately equal to the real | gn § = e _

With the good insulation of low-loss capacitors (delta ~0° and

Quality factor

=1 _k_P_,c
QF = g -wCR

tan & =IC

Power factor

PF=cos(p=||i

current (I); resulting in a negligible deviation of the values tan delta and cos phi. In Europe, the dissipation
factor tan delta is the most usual figure used to describe dielectric losses, while in North America power factor
(PF = cos phi) is commonly used. The ICMflex software displays both values, together with the calculated
capacitance, the voltages, and the frequency.
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10.2 Troubleshooting
The personal computer cannot find the ICMflex

If no communication between the ICMflex and the software can be established, please reboot the control
computer and check:

@ that all necessary drivers are properly installed (see sections 4.2 and 4.3)

® that the battery is charged.
To do this, measure the DC voltage when trying to establish a connection to the ICMflex. Connect the bat-
tery to the ICMflex as shown in Figure 106 (check the polarity first!). If the voltage is 10.5V or less, the
battery has to be recharged. If the voltage drops even after charging for at least six hours, the battery is

faulty.

Figure 106: Testing the voltage of the battery
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The ICMflex application window appears very small on high resolution monitors in Windows 10.

On PCs running Windows 10 with the Creator's Update of 2017 the
ICMflex application window may appear very small on high resolution
monitors. To increase the size of the window, take the following steps:

1.
2.

Figure 108: Desktop before and after changing scaling behaviour

Right-click on the application shortcut on the desktop.

Choose “Properties” from the context menu, which will open the
“Properties” window (Figure 107).

Enable “Override high DPI scaling behaviour” and set “Scaling per-
formed by” to “System” on the “Compatibility” tab.

If you have administrator rights, you can change the settings for all
users by clicking the corresponding button.

Approve the change by clicking “OK”.

Security Details Previous Versions
General Shortcut Compatibility

If this program isn't working correctly on this version of Windows,
try running the compatibility troubleshooter.

| Run compatibility troubleshooter

How do | choose compatibility settings manually?
Compatibility mode
|:| Run this program in compatibility mode for:

Windows 8

Settings
[[]Reduced colour mode
8-bit (256) colour

[[] Run in 640 x 480 screen resolution

Override high DPI scaling behaviour.
Scaling performed by:

System v

[] Disable full-screen optimisations

D Run this program as an administrator

E;'Change settings for all users

OK Cancel Apply

Figure 107: Properties window

g
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10.3 National Instruments hardening guide
10.3.1 Introduction

These instructions will guide you through the Power Diagnostix proposed cyber security operation system
hardening after the installation of a National Instruments based software product. The configuration refers
only to the Power Diagnostix software products. If any other third-party National Instruments-based software
products are installed or required, the proposed configuration should be adjusted in line with the configura-
tion of the responsible manufacturer.

This configuration guide will close three unnecessary National Instruments services. The local ports 3848
UDP and TCP opened by these services will also be closed.

[55] nidmsry.exe 3848 TCPYE  [0:0:0:0:0:0:0:7] 49672 [0:0:0:0:0:0:0:1] 49673 ESTABLISHED
[m5] ridmsrv.exe 3848 TCPYE  [0:0:0:0:0:0:0:1] 49673 [0:0:0:0:0:0:0:1] 49672 ESTABLISHED
[#] ridmsrvexe 3848 TCP DESKTOP-Q5MEFBE 59111 DESKTOP-GSNE... O LISTENING
[55] nidmsrv.exe 3848 UDP DESKTOP-QSMEFBE 5000 * *

(55 midmsry,exe 3848 UDP DESKTOP-Q5NEFBE 6000 * *

10.3.2 Step-by-step guide

Best match

1.) Open the Windows start menu and type “services.msc”.
Services
i Desktop app

2.) Click on the search result named “Services”. The “Services” window will open.
3.) Locate the following in the service list:

® NI Domain Service

® NI PSP Service Locator

® NI Time Synchronization

L — e R —
£+ NI Domain Service Provides a domain server for NI Shared Vanable se... Running  Automatic Local Syste...
-\S:J‘; MI PSP Service Locator Locates servers at the request of network vaniable c... Running  Automatic MNetwork 5S...
-E.';J_; MI Time Synchronization Allows this machine to keep its time synchronized ... Running  Automatic Local Syste...

4.) Open the configuration popup by double clicking each SEerviCe [ nipomsin senice propertes (Local Computen x

and change the “Startup type” to “Disabled”. General | [og On | Recovery | Dependercics

5.) Save the changes with the button “OK”. Seveename: - NilomanSenice

Display name: NI Demain Service
Description Provides a domain server for NI Shared Varable ~
: security. ¥ this senvice is stopped or disabled. this
s rhing will ha smshls tn 30t 30 3 damsin when
Path to executable:
"C:\Program Files (xB6)\National Instruments‘\Shared\Security\nidmsrv exe"

Startup type: Disabled ~

Service status:  Stopped
St | Stop Pause Resume

You can speciy the start parameters that apply when you start the service
from here.

Start parameters: |

(o ][ comed |1 somy

pdix.com User guide for ICMflex 87




ICMflex
Partial discharge and loss factor measurement system

10.3.3 Service description

http://www.ni.com/pr t- mentation/14487/en

NI Domain Service

Service: NIDomainService
Process: nidmsrv. exe

Description: Provides a domain server for NI Shared Variable security.

If Disabled: If this service is stopped or disabled, this machine will be unable to act as a domain when configuring shared vanable
security.

NI PSP Service Locator

Service: IkClassAds
Process: |kads exe

Description: Locates servers at the request of network variable clients and other proprietary NI network protocols

If Disabled: If this service is stopped or disabled, network variables and network streams will stop working.

Ml Time Synchronization

Service: kTimeSync
Process: [kisrv.exe

Description: Allows this machine to keep its time synchronized with & master time server, orto act as a time server for other machines.
This feature is configured with the Shared Variable Engine seftings in LabWVIEW.

If Disabled: If this service is stopped or disabled, this form of fime synchronization will not be available.
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C
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Low level discriminator................... 31,42, 46, 55, 70, 74
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Current transformer ..........cccooeiii 31,41, 42 64, 65, 69, 70
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D Preferences ..o 21,34, 35,57, 61, 70, 71
Digital storage 0sCilloSCOPE.........cccoviiviiiiiiiiiii, 26, 48 R
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T 17 19. 20 85 Reference capacitor...................cc......... 10, 14, 32, 79, 83
DSO display ............................................................. 37 Report .......................................................... 34,35, 37,63
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I TR Er 12,79
Time domain reflectometry .................. 12, 26, 27, 44, 46
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